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ABOUT THIS GUIDE 

 
 

USING THE ONESOURCE INDIRECT TAX INTEGRATION 
FOR ORACLE 12 PROCURE TO PAY (P2P) 

If you are using Oracle 12, you can integrate your Oracle Payables and Oracle Purchasing 

modules with ONESOURCE Indirect Tax Determination using the Integration software. This 

integration with Determination delivers some key benefits: 
 

• Fast and accurate tax results for sales, use, consumers use, and value-added tax (VAT) 

transactions. 

• A complete audit database from which you can generate both standard and custom reports. 

• Flexible configuration that allows you to work within your business requirements. 

 
Once your organization installs the Integration, your Oracle 12 Payables/Purchasing 

implementation can leverage the full set of calculation, auditing, and reporting features of 

Determination. 
 

This guide is intended for use by purchasing agents, accounting professionals, and tax 

professionals who use Determination to determine tax for transactions in Oracle Payables and 

Oracle Purchasing. 

 
 

HOW THIS GUIDE IS ORGANIZED 

This guide contains the following chapters: 
 

• CONFIGURING ONESOURCE INDIRECT TAX INTEGRATION PROFILE OPTIONS 

(page 3) describes how to configure Integration options, how ONESOURCE Indirect Tax 

Determination handles various scenarios, and the requirements for each transaction. 

• PURCHASING TAX CALCULATIONS (page 57) describes the Oracle Purchasing process 

and shows specific scenarios, including multiple Ship To locations and viewing tax. 

• PAYABLES TAX CALCULATIONS (page 69) describes the Oracle Payables process and 

the Sabrix Accrual Process, including process flows and examples. Other sections discuss 

additional transactions such as cancelling invoices, running debit memos, and reversals. 

• ENABLING ONESOURCE INDIRECT TAX DETERMINATION FEATURES (page 121) 

describes Direct Pay Permits, Allocations, and Custom Authorities. 

• TAX RATE CODES AND GENERAL TAX ACCOUNT (page 129) describes how to 

configure the default accounting. 

• REPORTING (page 147) explains how to run the Sabrix AP Accrual Report, the Sabrix Log 

Manager, and the Sabrix Transaction Manager. 
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2 ABOUT THIS GUIDE 

Style Conventions 

 

 

STYLE CONVENTIONS 

This section describes the styles used in this document. 
 

Bold text indicates commands, most User Interface elements (pages, windows, menu items, 

buttons, and so on), and values that can be selected from the User Interface. 
 

Italic text indicates user input, file and directory names, user names, and websites. 
 

Courier text indicates command-line or text file input. 
 

Indicates suggestions or additional, detailed information. 

 
 

 
Indicates important text that should be carefully reviewed before proceeding. 



3 

ONESOURCE INDIRECT TAX INTEGRATION FOR ORACLE 12 

PROCURE TO PAY USER’S GUIDE - VERSION 5.6.2.4 

 

 

 

CONFIGURING ONESOURCE INDIRECT 

TAX INTEGRATION PROFILE OPTIONS 

 

Oracle profile options are configurable options that affect the way your Oracle application looks 

and behaves. You can configure ONESOURCE Indirect Tax Integration profile options so that your 

transactions meet your business requirements. You can set options at various levels depending on 

how you want the applications to respond to users, including: 
 

• Site level 

• Application level 

• Organization level 

• Responsibility level 

• Country level 

• State level 

• User level 

 
 

For a complete list with detailed information and recommended settings about configuring 

Integration profile options, see the ONESOURCE Indirect Tax Integration for Oracle 12 Installation 

and Configuration Guide. 

For more information about Oracle profile options, see the Oracle documentation. 

 
This chapter describes various scenarios and how the profile option settings for the Integration can 

be modified to produce different GL accounting results. You will learn about: 
 

• CONFIGURING PROFILE OPTIONS (page 4) 

• CONFIGURING PROFILE OPTION AT THE STATE LEVEL (page 16) 

• SETTING EBTAX: SABRIX TAX ACCOUNTING LEVEL (page 19) 

• DETERMINING GL ACCOUNTS FOR U.S. SALES AND USE TAX (page 22) 

• WORKING WITH TAX TOLERANCES (page 43) 

• SETTING EBTAX: SABRIX AP WRITE DISTRIBUTIONS TO INVOICE? (page 49) 

• ORACLE PROJECT ACCOUNTING (page 53) 

• SETTING EBTAX: SABRIX AP SKIP FULLY PAID U.S. INVOICES (page 55) 
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CONFIGURING PROFILE OPTIONS 

The following profile options were created during the installation of the ONESOURCE Indirect Tax 

Integration and are configured in Oracle. 
 

To set the Integration specific profile options in Oracle: 
 

1. Select the System Administrator responsibility. 

2. Navigate to Profile > System and click Open. 

3. Enter %Sabrix% in the Profile field and click Find. 

4. The table below lists the profile options for the Integration for the P2P flow. Record your own 
choices in the Your Value column: 

 

Profile Options Required by ONESOURCE Indirect Tax Integration for P2P Flow 

Profile Option Set To Your Value 

eBTax: AP Sabrix 

Audit 

Determination Tax 

Amount 

Set to one of the following for AP: 

• Yes: Saves the Tax Control Amount 

in the vendor_tax and 

Determination calculated tax in the 

tax_amount audit fields. 

• No: Saves the Determination 

calculated tax in both vendor_tax 

and tax_amount audit fields. 

• NULL value behaves as a Yes 

value. 

 
Note: This profile option only applies 

to non-U.S. transactions. 

 

eBTax: AP Sabrix 

Use Trx Date to 

Lookup 

Registrations 

Set to one of the following for AP: 

• Yes: The supplier registration is 

looked up using the APTransaction 

Date. 

• No: The supplier registration is 

looked up using the sysdate. 

• NULL value behaves as a Yes 

value. 

 

eBTax: Sabrix AP 

Approve Invoices 

Set to one of the following for AP: 

• Yes: Allows an invoice that is short- 

paid to retain its approved status. 

• No: Sends the transaction back 

through the AP approval workflow (if 

enabled at your company). 

• NULL value behaves as a Yes 

value. 
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Profile Options Required by ONESOURCE Indirect Tax Integration for P2P Flow 

Profile Option Set To Your Value 

eBTax: Sabrix AP 

Audit Online Tax 

Calc 

The installation defaults to Yes. 

Set to one of the following for AP: 

• Yes: AP Transactions are sent to 

Determination Audit. 

• No: AP Transactions are not sent to 

Determination Audit. 

• NULL value behaves as a Yes 

value. 

 

eBTax: Sabrix AP 

Batch by Lines 

Set to one of the following for AP: 

• Yes: Use the number of invoice 

lines to determine the number of 

workers to submit when runningthe 

Sabrix Tax Process concurrent 

process. 

• No: Use the number of invoices to 

determine how many workers to 

submit when running the Sabrix 

Tax Process concurrent process. 

 

eBTax: Sabrix AP 

Create 

Transactions 

Set to one of the following for AP: 

• Yes: Create data in the 

sabrix_transactions_ap table (data 

used for Sabrix Accrual Report). 

• No: Do not create data in the 

sabrix_transaction_ap table. 

• NULL value defaults to No. 

Note: If this profile option is not set to 

Yes, there will be no data for the 

Sabrix Accrual Report in the 

sabrix_transactions_ap table. 

 

eBTax: Sabrix AP 

Exclude VAT from 

Sabrix Tax 

Process 

To bypass tax calculation from the 

ONESOURCE Integration concurrent 

tax process (Sabrix Tax Process) for 

non-U.S. AP invoices processed prior 

to the ONESOURCE Integration 

5.6.x.x online tax calculation. 

• Yes: Excludes non-U.S. AP invoices 

processed prior to 5.6.x.x from 

Sabrix Tax Process. 

• No: Does not exclude non-U.S. AP 

invoices processed prior to 5.6.x.x 

from Sabrix Tax Process. 

• NULL value defaults to No. 
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Profile Options Required by ONESOURCE Indirect Tax Integration for P2P Flow 

Profile Option Set To Your Value 

eBTax: Sabrix AP 

Hold? 

• Set toYes to apply an AP Hold 

Reason. 

• Set to No to not apply a Hold on US 
invoices for manual processing of US 

  Out of Tolerance Hold invoices. 

 

eBTax: Sabrix AP 

Maximum 

Workers 

Allows you to set a maximum number 

of concurrent processes that are 

submitted from the Sabrix Tax 

Process for AP. 

If the limit is reached, any 

transactions that are not picked up 

will be processed in the next run of 

the Sabrix Tax Process. 

A null value defaults to a limit of 20. 
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Profile Options Required by ONESOURCE Indirect Tax Integration for P2P Flow 

Profile Option Set To Your Value 

eBTax: Sabrix AP 

Overcharge 

Shortpay Action 

To handle Vendor Tax Overcharges 

outside the tolerance levels specified 

by the two tolerance profile options 

below, you can set this option to: 

• ACCRUE - Prorate By Item: 

Enables accrue shortpay 

functionality for incorrect vendortax 

charges, prorated by item line 

amounts. The invoice amount will 

not change, but invoice lines and 

distribution line entries are created 

as Sabrix Tax Accrual and Sabrix 

Tax Expense for the vendor 

overcharged tax amount. 

• ACCRUE - Prorate By Tax: Enables 

accrue shortpay functionality for 

incorrect vendor tax charges, 

prorated by individual tax 

percentages. The invoice amount 

will not change, but invoice lines 

and distribution line entries are 

created as Sabrix Tax Accrual and 

Sabrix Tax Expense for the vendor 

overcharged tax amount. 

• OFF: The invoice amount will not 

change and NO invoice lines and 

distribution line entries arecreated 

as Sabrix Tax Accrual and Sabrix 

Tax Expense for the vendor 

overcharged tax amount. Use this 

option to eliminate negative tax 

accruals. 

• PARTIAL: This will reduce the 

invoice total by the difference 

between the calculated and invoiced 

vendor tax amount, and Sabrix 

generated partial short pay entry 

lines are created for the vendor 

overcharged tax amount. 

• TOTAL: This will reverse the entire 

vendor tax amount, reduce the 

invoice amount by the vendor tax 

amount, and make entries to self- 

assess the tax amount. 

• Null value default is treated as 

ACCRUE - Prorate By Item setting. 
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Profile Options Required by ONESOURCE Indirect Tax Integration for P2P Flow 

Profile Option Set To Your Value 

eBTax: Sabrix AP 

Skip Fully Paid 

U.S. Invoices 

Set to one of the following for AP: 

• Yes: Skip fully paid U.S. AP invoices 

from Sabrix tax calculation. 

• No: Do not skip fully paid U.S. AP 

invoices from Sabrix tax calculation. 

• NULL value defaults to NO 

 

eBTax: Sabrix AP 

Tax Expense 

Account Source 

This is a required setting. 

Set to one of the following for use by 

the Integration Sabrix Tax Process: 

• Tax: Use the GL account that is set 

up on the tax code for expense 

accounting. 

• Item: Use if the GL account should 

be taken from the line item. 

 

eBTax: Sabrix AP 

Tax Grouping 

Rule 

Defines how Project Accounting will 

be used when the Integration groups 

tax distributions for AP. 

• DEFAULT: Groups by the tax 

distribution account. 

• PROJECT: Groups by 6 default 

project fields. 

• CUSTOM: Groups by up to 10 user- 

definable project fields. 

For more information, see 

“Programming User Exits” in the 

ONESOURCE Indirect Tax 

Integration for Oracle 12 Installation 

and Configuration Guide. 

 

eBTax: Sabrix AP 

Tolerance Amount 

A tolerance amount to determine at 

which point the Integration should 

accrue tax. 

If tax is within the amount entered 

here, no accruals will be returned to 

the AP invoice. 

Note: A null or 0 value is acceptable if 

you do not wish to use tolerances. 

 

eBTax: Sabrix AP 

Tolerance Percent 

A tolerance percentage to determine 

at which point the Integration should 

accrue tax. If tax is within the 

percentage entered here, no accruals 

will be returned to the AP invoice. 

Example: enter 10 if you wish to use 

10% as your threshold. 

Note: A null or 0 value is acceptable if 

you do not wish to use tolerances. 
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Profile Options Required by ONESOURCE Indirect Tax Integration for P2P Flow 

Profile Option Set To Your Value 

eBTax: Sabrix AP 

Undercharge 

Shortpay Action 

To handle Vendor Tax Undercharges 

outside the tolerance levels specified 

by the two tolerance profile options 

above, you can set this option to: 

• ACCRUE - Prorate By Item: 

Enables accrue shortpay 

functionality for incorrect vendortax 

charges, prorated by item line 

amounts. The invoice amount will 

not change, but invoice lines and 

distribution line entries are created 

as Sabrix Tax Accrual and Sabrix 

Tax Expense for the vendor 

undercharged tax amount. 

• ACCRUE - Prorate By Tax: Enables 

accrue shortpay functionality for 

incorrect vendor tax charges, 

prorated by individual tax 

percentages. The invoice amount 

will not change, but lines and 

distribution line entries are created 

as Sabrix Tax Accrual and Sabrix 

Tax Expense for the vendor 

undercharged tax amount. 

• OFF: The invoice amount will not 

change and NO distribution line 

entries are created as Sabrix Tax 

Accrual and Sabrix Tax Expense for 

the vendor undercharged tax 

amount. 

• PARTIAL: This will increase the 

invoice total by the difference 

between the calculated and invoiced 

vendor tax amount, and Sabrix 

generated partial short pay entry 

lines are created for the vendor 

undercharged tax amount. 

• TOTAL: This will reverse the entire 

vendor tax amount, reduce the 

invoice amount by the vendor tax 

amount, and create entries to self- 

assess the tax amount. 

• Null value default is treated as 

ACCRUE - Prorate By Item setting. 
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Profile Options Required by ONESOURCE Indirect Tax Integration for P2P Flow 

Profile Option Set To Your Value 

eBTax: Sabrix AP 

Write 

Distributions to 

Invoice? 

Set to Yes, No or Exclude to prevent 

Determination from creating AP 

Distribution Lines. 

• YES: Writes lines to the 

AP_DISTRIBUTION table. 

• NO: Does not write lines to the 

AP_DISTRIBUTION table. 

• NULL value behaves as a Yes 

value. 

• EXCLUDE: Omits tax types of IM, 

AC, and RC. 

Note: EXCLUDE value is no longer 

applicable for non-U.S. transactions 

and will be deprecated in a future 

release. 

 

Note: For more information on tax 

types, see ONESOURCE Indirect Tax 

Determination Online Help. 

 

eBTax: Sabrix 

Allow Sabrix 

Table Truncate 

• Yes: The ‘Sabrix Log Maintenance’ 

concurrent program will process the 

‘PURGE’ action, and purge the 

records in the SABRIX_LOG table 

according to the specified 

parameters. 

• No: The ‘Sabrix Log Maintenance’ 

concurrent program will notprocess 

the ‘PURGE’ action. 

• NULL: value defaults to No. 

 

eBTax: Sabrix 

Calculate Tax on 

Purchase Orders 

Set to one of the following for AP: 

• Yes: Allows Purchase Orders to be 

taxed by Determination. 

• No: Does NOT allow Purchase 

Orders to be taxed by 

Determination. 

• NULL value defaults to Yes. 
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Profile Options Required by ONESOURCE Indirect Tax Integration for P2P Flow 

Profile Option Set To Your Value 

eBTax: Sabrix 

Company 

A value that maps exactly to an 

External Company ID set in 

Determination for the desired 

company. This option can be set 

multiple times (by operating unit 

responsibility) depending on the 

complexity of your configuration. You 

must choose one of the options 

below: 

• The External Company ID in 

Determination must be identical to 

the Oracle accounting flexfield 

balancing segment. 

• To use the accrual roll-up by 

company, the value entered in this 

field would be either 

BALANCE_SEGMENT or 

SEGMENT*_VALUE. Thecompany 

value in Oracle 

AP>Setup>Options>Financial 

Options (T) Accounting Liability 

account field is used as the 

company value to send to 

Determination during the Payables 

tax call. For more information, see 

Multiple Company Segments for 

a Single AP Invoice (page 27) in 

the ONESOURCE Indirect Tax 

Integration for Oracle 12 Procure to 

Pay User’s Guide. 

This field needs to be set at the 

Application level for the other 

ONESOURCE Indirect Tax 

Integrations your company is using. 

This would include Order 

Management, Receivables, 

Purchasing and Payables. 

 

eBTax: Sabrix 

Compress Tax 

Lines 

To summarize tax results instead of 

displaying detailed tax and 

distribution lines for U.S. transactions. 

• Yes: Tax results for each item line 

are compressed/summed into a 

single tax and distribution line. 

• No: Tax results for each item line will 

have multiple tax lines and 

distributions if multiple tax blocks 

are returned by ONESOURCE 

Determination. 

• NULL: value defaults to No 

 



12 CONFIGURING ONESOURCE INDIRECT TAX INTEGRATION PROFILE OPTIONS 

CONFIGURING PROFILE OPTIONS 

ONESOURCE INDIRECT TAX INTEGRATION FOR ORACLE 12 

PROCURE TO PAY USER’S GUIDE - VERSION 5.6.2.4 

 

 

 

 

Profile Options Required by ONESOURCE Indirect Tax Integration for P2P Flow 

Profile Option Set To Your Value 

eBTax: Sabrix 

Debug Level 

Set to one of the following for 

SABRIX_LOG table: 

• ALL: Writes all debug messages. 

• XML: Writes only XML messages. 

Note: In order to generate the Sabrix 

XML Report or Sabrix Log Report, the 

profile option must be set to either 

ALL or XML prior to executing a 

transaction. 

• OFF: Does not write messages. 

• USER: Writes all debugmessages. 

• WARNING: Writes non-severe 

warning messages. 

• TIMING: Writes procedure entry and 

exit messages for AP transactions 

in the SABRIX_LOG table. 

 

eBTax: Sabrix 

Disable Tax Flow 

Creation 

Set to one of the following for 

automatic creation of Tax to Rate 

flows: 

• Yes: Disables Automatic Tax Flow 

Creation from existing tax flow 

including Source tax flows 

associated to an ERP Tax Code. 

Transactions will error with no tax 

code found message. 

• No: Enables creating automatic tax 

flows. 

• NULL: value defaults to No 

 
NOTE: In order to suppress Source 

Flow creation the Profile Option 

eBTax: Sabrix Disable Tax Flow 

Creation must be set to ‘Yes’ prior to 

running the sabrix_insert_config.sh 

script. 

 

eBTax: Sabrix 

Enable Persistent 

Connection 

Set to one of the following: 

• Yes: Enables persistent connection. 

• No: Does not enable persistent 

connection 

• NULL: value defaults to No 

 

Note: Set to No or leave null value 

when using ONESOURCE 

Integration for Oracle connected to 

ONESOURCE Determination in a 

Cloud environment. 
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Profile Options Required by ONESOURCE Indirect Tax Integration for P2P Flow 

Profile Option Set To Your Value 

eBTax: Sabrix 

Enable Tax 

Calculation 

ByPass 

Set to one of the following to enable 

bypassing tax calculation: 

• Yes: Allows bypassing tax 

calculation for online tax 

calculations. No tax will be 

calculated on the transactions. 

 

• No: Does not allow bypassing tax 

calculation for online tax 

calculations. Tax will be calculated 

on the transactions. 

• NULL: value defaults to No 

Note 1: Yes setting has to be used in 

conjunction with BypassCalc User 

Exit to not have tax calculated. For 

more information, see “BYPASSING 

TAX CALCULATIONS ” in the 

ONESOURCE Indirect Tax 

Integration for Oracle 12 Installation 

and Configuration Guide. 

Note 2: Yes setting takes precedence 

over existing profiles (i.e. eBTax: 

Sabrix Calculate Tax on Purchase 

Orders and eBTax: Sabrix O2C Tax 

Calculation) 

eBTax: Sabrix 

Hosted Unique 

Identifier 

• Any non-null value. 

• Used to pre-pend to the 

External_Company_ID in the 

Sabrix_Invoice table, making the 

External_Company_ID unique 

across all Determinationcompanies 

in a cloud environment. 

 

• The value will be reflected in the 

INDATA XML. 

There is no default. 

eBTax: Sabrix Set 

HTTP Header 

SOAP Action 

• Yes: The SOAP Action is set in the 

HTTP header. 

• No: The SOAP Action is not set in 

the HTTP header. 

• Null: Defaults to No. 
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Profile Options Required by ONESOURCE Indirect Tax Integration for P2P Flow 

Profile Option Set To Your Value 

eBTax: Sabrix 

System Print 

Structure 

This profile option is used in 

conjunction with eBTax: Sabrix 

Debug Level. 

• ON: Prints data structures. 

• OFF (and any other value): 

Prevents the structures from printing 

to the sabrix_log table. 

Note: For O2C and P2P transactions 

the input transaction view values can 

be used for debugging. Set to OFF in 

a production environment in 

conjunction with the profile option 

eBTax: Sabrix Debug Level set to 

OFF. 

 

eBTax: Sabrix 

TCE: Delimiter 

Enter the delimiter to use when 

concatenating the tax code with other 

elements. The options are: 

• . (period): Uses a period to delimit 

tax code extension segments 

• null (no delimiter): Does not use any 

delimiter to separate tax code 

extension segments. 

• _ (underscore): Uses an underscore 

to delimit tax code extension 

segments. 

 

eBTax: Sabrix 

TCE: Exempt 

Enter the character(s) to denote that 

the tax code is for an exempt 

transaction. 

 

eBTax: Sabrix 

TCE: Tax 

Direction 

Enter one of the following: 

• N: Disables the Tax Direction 

extension for tax codes and tax 

accounting. 

• Y: Enables the Tax Direction 

extension for tax codes and tax 

accounting. 

 

eBTax: Sabrix 

TCE: Tax Rate 

Enter one of the following: 

• N: Disables the Tax Rate extension 

for tax codes and tax accounting. 

• Y: Enables the Tax Rate extension 

for tax codes and tax accounting. 
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Profile Options Required by ONESOURCE Indirect Tax Integration for P2P Flow 

Profile Option Set To Your Value 

eBTax: Sabrix 

TCE: Tax Type 

Enter one of the following: 

• N: Disables the Tax Type extension 

for tax codes and tax accounting. 

• Y: Enables the Tax Type extension 

for tax codes and tax accounting. 

 

eBTax: Sabrix Tax 

Accounting Level 

Select one of the following: 

• BASIC: Enables Integration basic 

tax accounting preferences. 

• EXTENDED: Enables Integration 

extended tax accounting 

preferences. 
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CONFIGURING PROFILE OPTION AT THE STATE LEVEL 

This feature allows customers to define which state tax rates are to be used by the Integration 

when determining what tax to accrue, or to shortpay the vendor using the Integration partial or total 

method. Individual state specific profile option values will accrue tax based on company role as 

buyer or seller for either use tax rate and amounts, or sales tax rates and amounts, or the lower or 

higher tax rate results returned from Determination. 
 

There are independent authorities within some states, such as IL, CO, NM, MO, AL and HI, which 

have different rates for use and sales tax. In these scenarios, there could be differences in the 

accrual or shortpay tax amounts a company would record and report to specific authorities. For 

many of the authorities, the use and sales tax rates are the same. In these scenarios there is no 

difference in the tax accrual or shortpay entries. 
 

The state profile option value setting will only apply when there is a vendor charged tax (VCT) in 

the U.S. that is greater than $.00. 
 

Otherwise, for a U.S. AP transaction where the VCT total tax amount is zero on the AP transaction, 

like $ .00 entered on AP Tax Control Amount or $ .00 on Tax Details form, Integration will make the 

tax call with the company role as Buyer and populate the use tax rates and amounts. This is 

regardless of any state profile option setting values. So, the tax accrued will be based on the use 

tax rate and amounts, and not the state tax rate and amounts. 
 

The following are the state specific values and descriptions: 
 

Profile Option for SBX_STATES Value Set 
State Specific Values 

Value Description 

CU ALWAYS Always use Consumers Use result 

ST ALWAYS Always use Sales Tax result 

USE CU IF CU =< VCT < 

ST 

Use Consumers Use Tax if Vendor Charged Tax is between 

Consumers Use Tax and Sales Tax 

USE CU IF ST = CU Use Consumers Use Tax if Sales Tax equals Consumers Use 

Tax 

USE CU IF VCT < CU TAX Use Consumers Use Tax if Vendor Charged Tax is less than 

Consumers Use Tax 

USE CU IF VCT > ST AND 

CU 

Use Consumers Use Tax if Vendor Charged Tax is greater 

than Sales Tax and Consumers Use Tax 

USE ST IF VCT > ST AND 

CU 

Use Sales Tax if Vendor Charged Tax is greater than Sales Tax 

and Consumers Use Tax 

 
 

If none of the above conditions for SBX_STATES value set are met or a specific state has a null 

value, the default (based on historical) behavior is to use the State Sales Tax Rates when there is 

VCT for an AP transaction. 
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ENTERING VENDOR CHARGED TAX FOR STATE 

Thomson Reuters recommends entering the vendor charged tax (VCT) in the Tax Control Amount 

field at the AP invoice header for U.S. transactions. The online tax calculation will then allocate or 

prorate the tax to the appropriate authorities. The AP Sabrix Tax Process is dependent upon the 

online tax calculation VCT allocated/prorated tax authority amounts in order to properly allocate 

the tax amounts based on shortpay undercharge and overcharge profile settings. 
 

If you enter VCT by means of the Tax Details button, you must use tax flows that are related to 

particular states in order for the state-level options to be applied. Use of the DFLT flow will not 

result in state level options being applied since the state level VCT amount cannot be derived to 

compare to the company role for buyer and seller results. The best results will be attained by using 

the Tax Control Amount field on the invoice header to assure proper allocation/proration of tax 

amounts and comparisons for the state level options. 

 
 
 

In order for this feature to prorate and allocate tax correctly based on individual tax authorities 

rates, enter Vendor Charged Tax (VCT) in the invoice header Tax Control Amount field. 

 
• Do not use the Tax Details form to manually enter VCT. 

• Do not manually enter VCT using the DFLT Tax Rate Code since there is no state 

associated to DFLT tax rate code. 

 
 
 
 

STATE SPECIFIC TRANSACTION RESULTS AND LOGGING DETAILS 

 
Sabrix Tax Process Concurrent Log for State Value Settings 

The Sabrix Tax Process concurrent log will have a list of states and settings directly below the 

profile option setting listing any states which have a value. The states which do have a null setting 

value will not be displayed on the concurrent log. 

 
Batch Source Logging for State Results 

The SABRIX_TRANSACTIONS_AP table stores details of the final transaction results returned to 

AP invoices. 
 

Additional columns were added to the SABRIX_TRANSACTIONS_AP table to log the Batch 

Source ID along with other transaction results like Determination TAX_RATE_CODE, TAX_TYPE 

and Company Role. This allows for a persistent link between each tax line and the source batch of 

the values used in the Sabrix Tax Process. 
 

To populate the SABRIX_TRANSACTIONS_AP table with AP transaction data, enable the 

eBTax: Sabrix AP Create Transactions profile option by setting the value as Yes. 
 

To view the transaction results for the Sabrix generated accruals, run the AP Accrual Report. See 

SABRIX AP ACCRUAL REPORT (page 148) for more information. 
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To view what resulted from the state level options being applied, run the following query against 

the SABRIX_TRANSACTIONS_AP table: 
 

• select * from sabrix_transaction_ap where invoice_id = <invoice ID of transaction> 

 
 

This will show the resulting batch ID, the source batch ID, the tax rate code, tax type, company role 

as either Buyer or Seller, etc. for each tax line. 

 
 

The following table displays examples for the various State profile option settings for IL: 
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SETTING EBTAX: SABRIX TAX ACCOUNTING LEVEL 

The ONESOURCE Indirect Tax Integration for Oracle 12 Procure to Pay returns an ERP tax code. 

You can set the detail level of accounting distributions with Basic and Extended options. 
 

• BASIC is the standard tax code setting for Determination tax results. 

• EXTENDED uses a set of Integration-specific Oracle profile options to manage more 

granular levels of a tax code to support your accounting needs. 

 
Basic and Extended tax code processing is applicable to the AP online tax calculation for U.S. 

Sales and Use Tax transactions, and non-U.S. transactions (e.g. VAT), or with the AP Sabrix Tax 

Process for U.S.Sales and Use Tax transactions. 

 

BASIC TAX CODE PROCESSING 

The Oracle Tax Rate Codes are stored at each authority level in Determination. Each time tax is 

calculated for a document, the tax code determined by Determination is passed back to Oracle 

and verifies that the Oracle Tax Rate Code exists. 
 

During the implementation of the Integration, the Tax Rate Codes are loaded into your Oracle 

instance. The format for each tax rate code in the P2P workflow is outlined in the Tax Rate Code 

column in the table below. 

 
See the ONESOURCE Indirect Tax Integration for Oracle 12 Installation and Configuration Guide 

for more information about Tax Rate Codes. 

 
 

The resulting tax codes for both US and non-US transactions with the eBTax: Sabrix Tax 

Accounting Level profile option set to BASIC are as follows: 
 

Basic Tax Code Examples 

 
Type 

 
Tax Rate Code 

Tranaction Results 
Example 

U.S. based tax 

codes 

<ERP Tax Code>_P2P_<database sequence> USWA_P2P_2009 

(Taxable state of 

Washington) 

Canada based tax 

codes 

<ERP Tax Code>_P2P Tax 

Direction_<database sequence> 

ONHST_P2P_I_1492 

(Taxable province of 

Ontario, Canada) 

International based 

tax codes 

<ERP Tax Code>_P2P_Tax 

Direction_<database sequence> 

FRVAT_P2P_I_1582 

(Taxable country of France 

for Input “I” tax direction) 

FRVAT_P2P_O_1583 

(Taxable country of France 

for Output “O” tax direction) 
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SETTING EBTAX: SABRIX TAX ACCOUNTING LEVEL 

 

 
EXTENDED TAX CODE PROCESSING 

In order to use Extended Tax Code processing, the eBTax: Sabrix Tax Accounting Level must 

be set to EXTENDED. You can then use the following Tax Code Extension (TCE) profile options: 
 

• eBTax: Sabrix TCE: Delimiter 

• eBTax: Sabrix TCE: Exempt 

• eBTax: Sabrix TCE: Tax Direction 

• eBTax: Sabrix TCE: Tax Rate 

• eBTax: Sabrix TCE: Tax Type 

 
For more information on the ONESOURCE Indirect Tax Integration profile options, see 

CONFIGURING PROFILE OPTIONS (page 4) section. 

 

A basic tax rate code is set and extensions are appended to the basic tax rate code derived from 

the settings of the profile options above. 
 

After the basic tax rate code is set, the values of the eBTax: Sabrix TCE profile options determine 

what additional information will be appended to the basic tax rate code. 
 

The value entered for the profile option eBTax: Sabrix TCE: Delimiter determines if and how the 

extensions are separated. The values are a period (.) or underscore ( _ ) or you may leave null for 

no separation between the extensions (do not include the parentheses). 

 

The following table describes the logic used to determine the extended portion of the tax code. 
 

Extended Tax Code Example Results 

 
Basic Tax Code 

 
Delimiter 

Enabled “eBTax: Sabrix 
TCE: “ Profile Options 

 
Example 

FRVAT_P2P_I_1582 

<database 

sequence> 

period (.) Basic tax rate code and 

eBTax: Sabrix TCE: Tax Rate 

FRVAT.SR_P2P_I_1582 

FRVAT_P2P_I_1582 period (.) Basic tax rate code and 

eBTax: Sabrix TCE: Exempt 

FRVATEX _P2P_I_1583(if an 

exempt transaction) 

FRVAT_P2P_I_1582 period (.) Basic tax rate code and 

eBTax: Sabrix TCE: Tax Type 

FRVAT.AC_P2P_I_1582 

FRVAT_P2P_I_1582 period (.) Basic tax rate code 

eBTax: Sabrix TCE: Tax Type, 

and 

eBTax: Sabrix TCE: Tax Rate 

FRVAT.AC.SR_P2P_I_1582 

FRVAT_P2P_I_1582 period (.) Basic tax rate code 

eBTax: Sabrix TCE: Tax Type, 

eBTax: Sabrix TCE: Tax Rate, 

and 

eBTax: Sabrix TCE: Tax 

Direction 

FRVAT.AC.SR.I_P2P_I_1582 
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See ONESOURCE Indirect Tax Determination Online Help for more information about Tax Type, 

Tax Rate and Tax Direction. 

 
 

CREATE EXTENDED TAX RATE CODES IN ORACLE E-BUSINESS TAX 

• To use the extended tax codes functionality, configure the expected tax rate code values in 

the Oracle E-Business Tax Rate Code form. Steps to define Oracle Tax Rate Codes are 

outlined in CREATING ADDITIONAL TAX RATE CODES FOR PAYABLES (page 130). 

Alternatively, the Thomson Reuters One-Step Configuration can be used to setup the Tax to 

Rate flows in Oracle eBTax. See the ONESOURCE Indirect Tax Integration for Oracle 12 

Installation and Configuration Guide for more information 

• The extended tax rate codes must exactly match the values set up for Oracle E-Business 

Tax Rate Codes. For example, if you enabled all of the eBTax: Sabrix TCE profile options, 

you must create a tax rate code like FRVAT.AC.SR.I_P2P_I_12887. 

• If the tax rate code does not exist in Oracle, the transaction will fail. However, after the 

desired tax rate code is configured in Oracle E-Business Tax, and the transaction is 

reprocessed, it will complete normally. 

 
If a Default Flow is defined, the missing tax flow can automatically be created by the Integration 

during transaction processing. See the ONESOURCE Indirect Tax Integration for Oracle 12 

Installation and Configuration Guide for more information on defining tax flows and using defaults. 

 
 
 
 

An alternative to the extended tax code configuration in Oracle, the ONESOURCE Indirect Tax 

Determination Tax Code Qualifiers functionality can be used. See Determination online help for 

more information. 
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DETERMINING GL ACCOUNTS FOR U.S. SALES AND USE TAX 

You can use eBTax: Sabrix profile options to generate the desired accounting for the tax expense 

distributions written to your AP invoices by the Integration. The following sections describe: 
 

• GL Accounts for Vendor Charged Tax (page 22) 

• Default GL Accounts for Integration-Generated Miscellaneous Line Type (page 22) 

• Setting the eBTax: Sabrix AP Tax Expense Account Source Profile Option (page 23) 

• Setting the eBTax: Sabrix Company Profile Option (page 26) 

 
GL ACCOUNTS FOR VENDOR CHARGED TAX 

The GL account for the Vendor Charged Tax line will default from the Tax Rate Code or any other 

GL account based on your company’s defined precalc or postcalcs. 

 
See the “Post Installation: Technical Topics” chapter in the ONESOURCE Indirect Tax Integration 

for Oracle 12 Installation and Configuration Guide for information about Programming User Exits. 

 

 
DEFAULT GL ACCOUNTS FOR INTEGRATION-GENERATED MISCELLANEOUS 
LINE TYPE 

The Integration, in conjunction with Oracle Accounts Payable and Oracle E-Business Tax 

modules, generates a Miscellaneous Line Type for Sabrix Tax Expense and Sabrix Tax Accrual 

invoice line and invoice line distribution entries. The Tax Line Type is used for manually entered 

Vendor Charged Taxes (VCT) and for on-line tax calculated amounts. 
 

The following describes the default for GL Accounts for the Integration-generated Miscellaneous 

Line Type: 
 

• The Sabrix Tax Accrual GL account defaults from the Tax Recoverable/Liability account 

value defined on the Tax Rate Code entered in the Oracle E-Business Tax Sabrix Regime to 

Rate Flow. 

• The AP Sabrix Tax Process checks if the profile option eBTax: Sabrix AP Tax Expense 

Account Source is set to Tax or Item. 

• If it is set to Item, then the Sabrix Tax Expense GL account will be the same as the 

associated invoice item lines GL account. 

• If the profile option is set to Tax, the associated Tax Rate Code should have a value in 

the General Tax Accounts Tax Expense account in order for the Sabrix Tax Expense 

line to be processed without any errors. 

The eBTax: Sabrix Company profile option may affect the GL accounts if set to 

BALANCE_SEGMENT instead of using a constant value, like 01, for the Determination company. 

Using the BALANCE_SEGMENT setting ensures the GL accounting entries balance for each 

company segment. See Setting the eBTax: Sabrix Company profile option (page 4) for additional 

details. 
 

An exception to the use of the setting of the profile option eBTax: Sabrix AP Tax Expense 

Account Source is the Sabrix-generated short pay entry lines. These lines are created based on 

the short pay action described in the section PROFILE OPTIONS FOR SHORTPAY AND/OR 

ACCRUE (page 29). The GL account for the short pay lines is the same as the manual tax line 
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(Vendor Charged Tax). If no manual tax line exists on the invoice, the GL account is derived based 

on the profile option value. 

 
SETTING THE EBTAX: SABRIX AP TAX EXPENSE ACCOUNT SOURCE PROFILE 

OPTION 

You can set the eBTax: Sabrix AP Tax Expense Account Source profile option to use either Item 

or Tax as the value, as shown in the example screens below. 
 

Tax Rate Code General Tax Accounts for Tax Expense account is not required for the AP on-line 

tax calculation. During the on-line tax calculation if the Tax Expense GL account is null on the Tax 

Rate Code, the Tax Expense GL account will be the same as the associated invoice item lines GL 

accounts. 
 

The Integration Sabrix Tax Process checks if the profile option eBTax: Sabrix AP Tax Expense 

Account Source is set to Tax or Item. If it is set to Item, then the Sabrix Tax Expense GL account 

will be the same as the associated invoice item lines GL account. If it is set to Tax, the Tax 

Expense GL account is required on the associated Tax Rate Code for the Sabrix Tax Process to 

complete successfully. 

 
If the Tax Rate Code General Tax Accounts for Tax Expense is null, and vendor charged 
tax (VCT) is entered on the Tax Details Summary as a Tax Only Line, then GL Tax 
Expense Account is required. The Tax Only Line means the tax is not associated to an 
item line, therefore GL Tax Expense accounts cannot be determined when GL Tax 
Expense account is null on the Tax Rate Code. This is based on standard Oracle 
functionality to derive the GL Tax Expense account from the item line if it is null on the 
Tax Rate Code. Integration is also using the same functionality to use the item line GL 
account if the Tax Rate Code has a null GL Tax Expense account. 

 
When the profile option eBTax: Sabrix AP Tax Expense Account Source is set to Tax, 

the General Tax Accounts Tax Expense account is still required on the Tax Rate Codes 

for the Sabrix Tax Process. Otherwise the following error message will appear: 

“Error***Cannot Determine GL assignment for Sabrix Tax Code: XXXX. Please resolve 

and resubmit. Error*** Expense account does not exist - CCID:" 

 

Examples: Setting Profile Option to “Item” or “Tax” 

The two examples below for Tax Rate Code of USWA_P2P_2813 have the Tax 

Recoverable/Liability value for the GL account as 01-000-2520-0000-000. 
 

• The Sabrix Tax Expense GL account defaults from the Tax Expense account value defined 

on the Tax Rate Code in Oracle E-Business Tax Sabrix Regime to Rate Flow. 

• The Sabrix Tax Expense GL account is also dependent upon whether the eBTax: Sabrix AP 

Tax Expense Account Source profile option is set as Item or Tax. 

 
Example: Setting Profile Option to “Item” 

Setting the profile option to Item uses the General Ledger account combination from the invoice 

item distribution lines for the Sabrix Tax Expense Miscellaneous Line Type. 
 

In the example below, the Tax Rate Code of USWA_P2P_2813 has the GL Tax Expense account 

01-410-7710-0000-000 for the value. But, the eBTax: Sabrix AP Tax Expense Account Source 
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profile option value is set to Item, so the GL account from the Item Line Type is used for the Sabrix 

Tax Expense GL account of 01-422-5110-0000-000. 
 

The following shows the AP Invoice All Distributions form using the same GL account for the 

Item Line Type and the Determination Tax Expense Miscellaneous Line Type. 

 
 

 
Example: Setting Profile Option to “Tax” 

Setting the profile option to Tax uses the General Ledger account combination from the Tax 

Recoverable/Liability accounts associated to the Tax Rate Code for the Sabrix Tax Accrual 

Miscellaneous Line Type. 
 

In the example below, the Tax Rate Code of USWA_P2P_2813 has GL account 01-410-7710- 0000-

000 set for the Tax Expense value. The eBTax: Sabrix AP Tax Expense Account Source profile 

option value is set to Tax; so, the GL account from the Tax Rate Code of USWA_P2P_2813 GL 

account of 01-410-7710-0000-000 is used for the Sabrix Tax Expense. 
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The following shows the AP Invoice All Distributions form using the GL account from the 

USWA_P2P_2813 Tax Rate Code for the Sabrix Tax Expense Miscellaneous Line Type. 

The Integration for Oracle R12 does not use Offset Tax Rate Codes for P2P. AP Tax Codes in 

Oracle R11i only had one GL account for each Tax Code. Oracle eBTax Tax Rate Codes in R12 

have two GL accounts: 

• Tax Expense ( Not required for Integration on-line tax calculation, if null then Integration will use 

the item line GL account associated to the tax entry) and 

• Tax Recoverable/Liability (Required by Integration for O2C and P2P when creating Tax Rate 

Codes). 

 
To review VAT transactions, see the examples in VALUE ADDED TAX (VAT) TRANSACTIONS 

(page 74) 
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SETTING THE EBTAX: SABRIX COMPANY PROFILE OPTION 

For the eBTax: Sabrix Company profile option, enter the exact value that maps to an External 

Company ID created in ONESOURCE Indirect Tax Determination for the desired company. The 

External Company ID in ONESOURCE Indirect Tax Determination must be identical to an Oracle 

accounting flexfield balancing segment value. 

 
Single Company Segment for AP Invoices 

If you are processing transactions for a single company configured in Determination, simply enter 

the GL account company segment value with the External Company ID from your Determination 

configuration. 
 

The example below shows the External ID 01 for a single Company Name entered into 

Determination. This maps to the GL Account Segment value for the Company segment value 

of 01. 

 

You can set the eBTax: Sabrix Company profile option for each operating unit responsibility 

depending on the complexity of your configuration for Order Management, Receivables, 

Purchasing and Payables. 
 

See the examples in Setting the eBTax: Sabrix AP Tax Expense Account Source Profile 

Option (page 23) for single company distribution lines. 
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Multiple Company Segments for a Single AP Invoice 

If you process transactions for multiple companies, you may derive the Company segment value 

from the Oracle GL Balancing Segment based on the GL account structure defined. 
 

If a single AP invoice is entered with multiple invoice item lines and distribution lines with different 

company segment values, then the eBTax: Sabrix Company profile option value entered can be 

either BALANCE_SEGMENT or SEGMENT*_VALUE. The Integration will then group all GL 

accounting results by the company segment values to ensure the GL accounting entries balance 

for each company segment. The company value in Oracle AP > Setup > Options > Financial 

Options (T) Accounting Liability account field is used as the company value to send to 

Determination during the Payables tax call. 
 

For each Oracle GL accounting flexfield balancing segment value entered into the AP Invoice 

Distribution lines, make sure to also enter into Determination the multiple company names along 

with the appropriate External ID field for each company. 

 
The valid general ledger account code combinations must exist in Oracle in order for the correct 

accounting to be returned. 

 

The multiple company account segment values example below has the first item distribution line 

for Company 01 and the second item distribution line for Company 70. The Sabrix Miscellaneous 

Line Type distribution lines for the GL account values will be split between the company segment 

values of 01 and 70. This ensures that the accounting entries balance for each of the two 

company segment values. 
 

In the example below, the profile option eBTax: Sabrix AP Tax Expense Account Source is set 

to Tax. This ensures both the tax expense and accrual entries balance for the two company 

segment values plus the natural account segment. 
 

Otherwise if the profile option eBTax: Sabrix AP Tax Expense Account Source is set to Item, 

only the expense account entries are designated with the separate company segment. The accrual 

entry will be the General Tax Account for Tax Recoverable/Liability defined on the Tax Rate Code. 
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The following shows the AP Invoice All Distributions form. 

For additional details, see “Configuring Profile Options” in the ONESOURCE Indirect Tax 

Integration for Oracle 12 Installation and Configuration Guide. 

 
The previous examples show U.S. Sales and Use Tax transaction scenarios and their results after 

the Sabrix Tax Process has completed. 

 
 
 
 
 
 

The concurrent program Sabrix Tax Process is only applicable to U.S. Sales and Use 

Tax. This is due to ONESOURCE Indirect Tax Integration for Oracle 12 Version 5.6.0.0 

enhancing the P2P functionality for real time (online) tax calculations for recoverable tax 

details. 
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PROFILE OPTIONS FOR SHORTPAY AND/OR ACCRUE 

The following two profile options control the behavior of how U.S. Sales and Use Tax variances 

between the vendor charged tax and the Determination-calculated tax amounts are processed. 

These settings are not applicable for non-U.S VAT transactions : 
 

Control Processing Behavior of Sales and Use Tax Variances Between 
Vendor-charged Tax and Determination-calculated Tax Amounts 

Profile Options Description Allowable Values 

eBTax: Sabrix AP 

Overcharge Shortpay 

Action 

Handles vendor 

overcharged tax 

amounts. 

• ACCRUE - Prorate By Item: Enables accrue shortpay 

functionality for incorrect vendor tax charges, prorated 

by item line amounts. The invoice amount will not 

change, but line and distribution line entries are 

created as Sabrix Tax Accrual and Sabrix Tax 

Expense for the vendor overcharged or undercharged 

tax amounts. 

• ACCRUE - Prorate By Tax: Enables accrue shortpay 

functionality for incorrect vendor tax charges, prorated 

by individual tax percentages. The invoice amount will 

not change, but line and distribution line entries are 

created as Sabrix Tax Accrual and Sabrix Tax 

Expense for the vendor overcharged or undercharged 

tax amounts. 

• OFF: Turns off the shortpay and accrue functionality. 

The invoice amount will not change, and no invoice 

line or distribution line entries are created as Sabrix 

Tax Accrual and Sabrix Tax Expense for either 

supplier overcharged or undercharged tax amounts. 

For supplier overcharges, use this option toeliminate 

negative tax accruals. 

• PARTIAL: The invoice amount is reduced or increased 

by the difference between the Determination 

calculated tax and the invoice vendor tax amount. Plus 

Sabrix generated partial short pay entries lines are 

created for the vendor overcharged or undercharged 

tax amounts. 

• TOTAL: Reverses the entire vendor tax amount, 

reduces the invoice amount by the vendor tax amount 

and creates Sabrix Tax Accrual and Sabrix Tax 

Expense entries to self-assess the tax amount. 

NOTE: For PARTIAL and TOTAL shortpay profile 

options to function correctly, a non zero vendor charged 

tax amount (VCT) has to be entered for the AP invoice. 

Otherwise, when there is no vendor tax or zero vendor 

tax entered for the AP invoice, the Integration will 

default to using the ACCRUE - Prorate By Item 

functionality 

eBTax: Sabrix AP 

Undercharge 

Shortpay Action 

Handles vendor 

undercharged tax 

amounts. 

 
To avoid negative accruals, set the Overcharge action to OFF. This ensures that you do 

not accrue any vendor tax differences, nor will the invoice total be changed. 
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When the profile option for Overcharge is set to OFF, the information for the Vendor Overcharge 

amount will be displayed in the AP Invoice Distribution Line descriptive flexfield (DFF) for the 

Sabrix Tax Rate/Amount DFF attribute. No accrual entries are created. 
 

The Sabrix Item Link attribute usually displays an associated item line link for the Sabrix Tax 

Expense Miscellaneous distribution lines. But in the case of a vendor overcharge and the eBTax: 

Sabrix AP Overcharge Shortpay Action profile option is set to OFF, the Sabrix Item Link 

attribute will display a (-1) for only the first item line. 
 

You can create a custom report using the Sabrix Item Link attributes which have a (-1) to find 

vendors and invoices having overcharges. Example three below shows a Vendor Overcharge 

amount with the Sabrix Item Link DFF attribute with a (-1). 

 
 
 

Oracle reverses the original on-line tax calculated amounts and re-calculates the on-line tax 

amounts after the Sabrix Tax Process has completed. Therefore the descriptive flexfield Sabrix 

Tax Status will be null and not have a “T” status on the re-calculated tax lines. 
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EXAMPLES OF AP INVOICE DISTRIBUTION LINES 

This section has nine examples of AP invoices to display the invoice lines and/or distribution lines 

showing the results of invoices using the various shortpay options for: 
 

• Vendor charged no tax (treated as an undercharge) 

• Vendor charged tax equals Determination calculated tax amount 

• Vendor overcharged tax 

• Vendor undercharged tax 

 
There is also an example table after Example 8 to display the difference in tax accruals when using 

the ACCRUE - Prorate By Item and ACCRUE - Prorate By Tax profile option settings. 

 
 

Example 1. In the following example, the vendor did not charge tax on the invoice, so $.00 is 

entered into the Tax Control Amount field. 
 

Tax amounts entered into the Tax Control Amount field take precedence over the on-line tax 

calculation amounts, so all of the Tax lines returned will also be $.00. 
 

Profile Options are set to: Overcharge=OFF and Undercharge=ACCRUE - Prorate By Item. 
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After running the Sabrix Tax Process, Sabrix Tax Accrual and Sabrix Tax Expense lines and 

distribution lines are created to self-assess the tax returned from Determination which the vendor 

did not charge on the transaction. 
 

The descriptive flexfield Sabrix Tax Rate/Amount field on the Item Line Distribution is populated 

with Tax Rate, Tax Amount and Tax Accrued amount. 
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Example 2. The vendor charged tax of $95 equals the Determination calculated tax amount of 

$95; so no tax accrual is required. 
 

An online tax calculation is invoked at events such as when validating the invoice, when using the 

Calculate Tax button or the Tax Details button on the AP workbench. The Tax Control Amount 

field on the Invoice header is null. 
 

After running the Sabrix Tax Process, the descriptive flexfield Sabrix Tax Rate/Amount field on 

the Item Line Distribution is populated with Tax Rate, Tax Amount, Tax Accrued plus Vendor 

charged tax in tolerance. Since the tax calculated on the line is within tolerance and equals the tax 

calculated by the Sabrix Tax Process, no accrual entries are needed. 
 

Profile Options are set to: Overcharge=OFF and Undercharge=ACCRUE - Prorate By Item. 
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Example 3. The invoice vendor tax amount is $2.50 over the Determination $9.50 calculated tax 

amount. 
 

The vendor charged tax (VCT) of $12.00 is entered into the Invoice header Tax Control Amount 

field. 
 

Tax amounts entered into the Tax Control Amount field take precedence over the on-line tax 

calculation amounts. After clicking the Tax Details button (or the Calculate Tax button, and/or 

during Validation, etc.), the Tax Control Amount of $12.00 will be prorated based upon the 

transaction line amount of $100.00 along with the appropriate authority tax percentages returned 

from Determination. 
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After running the Sabrix Tax Process, the Vendor Overcharge tax amount of $2.50 is NOT 

accrued due to the Overcharge profile option being set to OFF. The descriptive flexfield Sabrix Tax 

Rate/Amount field on the Item Line Distribution is populated with Tax Rate, Tax Amount, Vendor 

Tax Amount plus Vendor Overcharged tax amount of $2.50. The descriptive flexfield Sabrix Item 

Link has a value of -1. 
 

Profile Options are set to: Overcharge=OFF and Undercharge=ACCRUE - Prorate By Item. 
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Example 4. The invoice vendor tax is $35 under the Determination calculated tax amount of $95. 
 

The vendor charged tax (VCT) of $60.00 is entered into the Invoice header Tax Control Amount 

field. 
 

Tax amounts entered into the Tax Control Amount field take precedence over the on-line tax 

calculation amounts. After clicking the Tax Details button (or the Calculate Tax button, and/or 

during Validation, etc.), the Tax Control Amount of $60.00 will be prorated based upon the 

transaction line amount of $1,000.00 along with the appropriate authority tax percentages returned 

from Determination. 
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After running the Sabrix Tax Process, the vendor charged tax difference from the Determination 

calculated tax amount of $35.00 is accrued. The descriptive flexfield Sabrix Tax Rate/Amount 

field on the Item Line Distribution is populated with Tax Rate, Tax Amount and Tax Accrued of 

$35.00. 
 

Profile Options are set to: Overcharge=OFF and Undercharge=ACCRUE - Prorate By Item. 
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Example 5. The vendor charged tax is $5.00, and the Determination calculated tax amount is 

$9.50. 
 

The vendor charged tax (VCT) of $5.00 is entered into the Invoice header Tax Control Amount 

field. 
 

Tax amounts entered into the Tax Control Amount field take precedence over the on-line tax 

calculation amounts. After clicking the Tax Details button (or the Calculate Tax button, and/or 

during Validation, etc.), the Tax Control Amount of $5.00 will be prorated based upon the 

transaction line amount of $100.00 along with the appropriate authority tax percentages returned 

from Determination. 
 

After running the Sabrix Tax Process, the Invoice Total is decreased by the Integration for the 

$5.00 vendor undercharged tax. The vendor is short paid by the amount of tax they charged and 
the TOTAL tax calculated by Determination is accrued. The descriptive flexfield Sabrix Tax 

Rate/Amount field on the Item Line Distribution is populated with Tax Rate, Tax Amount and Tax 

Accrued amount of $9.50. 
 

Profile Options are set to: Overcharge=TOTAL and Undercharge=TOTAL. 
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Example 6. The vendor charged tax is $12.00, and the Determination calculated tax amount is 

$9.50. 
 

The vendor charged tax (VCT) of $12.00 is entered into the Invoice header Tax Control Amount 

field. 
 

Tax amounts entered into the Tax Control Amount field takes precedence over the on-line tax 

calculation amounts. After clicking the Tax Details button (or the Calculate Tax button, and/or 

during Validation, etc.), the Tax Control Amount of $12.00 will be prorated based upon the 

transaction line amount of $100.00 along with the appropriate authority tax percentages returned 

from Determination. 
 

After running the Sabrix Tax Process, the Invoice Total is decreased by the Integration for the 

$12.00 vendor overcharged tax. The vendor is short paid by the amount of tax they charged and 

the TOTAL tax calculated by Determination is accrued. The descriptive flexfield Sabrix Tax 

Rate/Amount field on the Item Line Distribution is populated with Tax Rate, Tax Amount and Tax 

Accrued amount of $9.50. 
 

Profile Options are set to: Overcharge=TOTAL and Undercharge=TOTAL. 
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Example 7. The Vendor Charged Tax is $15, and the Determination calculated tax amount is 

$28.50 (VCT is $13.50 under the Determination calculated amount). 
 

The vendor charged tax (VCT) of $15.00 is entered into the Invoice header Tax Control Amount 

field. 
 

Tax amounts entered into the Tax Control Amount field takes precedence over the on-line tax 

calculation amounts. After clicking the Tax Details button (or the Calculate Tax button, and/or 

during Validation, etc.), the Tax Control Amount of $15.00 will be prorated based upon the 

transaction line amount of $300.00 along with the appropriate authority tax percentages returned 

from Determination. 
 

After running the Sabrix Tax Process, the Invoice Total is increased by the Integration for $13.50, 

so the Tax Amount paid to the vendor now equals the Determination calculated tax amount. The 

descriptive flexfield Sabrix Tax Rate/Amount field on the Item Line Distribution is populated with 

Tax Rate, Tax Amount and Invoice Increased amount of $13.50. 
 

Profile Options are set to: Overcharge=PARTIAL and Undercharge=PARTIAL. 
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Example 8. The Vendor Charged Tax is $36.00, and the Determination calculated tax amount is 

$28.50 (VCT is $7.50 over the Determination calculated amount). 
 

The vendor charged tax (VCT) of $36.00 is entered into the Invoice header Tax Control Amount 

field. 
 

Tax amounts entered into the Tax Control Amount field takes precedence over the on-line tax 

calculation amounts. After clicking the Tax Details button (or the Calculate Tax button, and/or 

during Validation, etc.), the Tax Control Amount of $36.00 will be prorated based upon the 

transaction line amount of $300.00 along with the appropriate authority tax percentages returned 

from Determination. 
 

After running the Sabrix Tax Process, the Invoice Total is reduced by the Integration for $7.50, so 

the Tax Amount paid to the vendor now equals the Determination calculated tax amount. The 

descriptive flexfield Sabrix Tax Rate/Amount field on the Item Line Distribution is populated with 

Tax Rate, Tax Amount and Invoice Reduced amount of $7.50. 
 

Profile Options are set to: Overcharge=PARTIAL and Undercharge= ACCRUE - Prorate By Item. 
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Example 9. The following examples show the results and differences in the accrue methods when 

using the ACCRUE - Prorate By Item or ACCRUE - Prorate By Tax profile option settings for a 

vendor charged tax undercharge and a vendor charged tax overcharge. The examples also show 

how the Tax Control Amount is prorated for each item line. 
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WORKING WITH TAX TOLERANCES 

Tax Tolerances allow you to specify acceptable minimum and maximum tolerance levels for 

variances between supplier charged tax amount and the Determination calculated tax amount. 

This section describes how to work with: 
 

• The eBTax: Sabrix AP Tolerance Amount and eBTax: Sabrix AP Tolerance Percent 

profile options. 

• The Sabrix Invoice Hold Reason of US Out of Tolerance Hold 

 
SPECIFYING THE EBTAX: SABRIX AP TOLERANCE AMOUNT AND EBTAX: SABRIX 
AP TOLERANCE PERCENT 

The eBTax: Sabrix AP Tolerance Amount and eBTax: Sabrix AP Tolerance Percent profile 

options are offered to set a threshold for processing transactions. The tolerances determine if the 

Integration needs to perform an action by either an accrual or a shortpay, depending on your 

shortpay settings. 

 
A null value in the eBTax: Sabrix AP Tolerance Amount or eBTax: Sabrix AP Tolerance 

Percent profile option is treated as a zero, making any deviation between VCT and the 

Determination result out of tolerance. 

 

For U.S. transactions, the tolerance profile options apply when running the AP Sabrix Tax Process. 

For non-U.S. transactions, the tolerance profile options apply when selecting Calculate Tax or 

Validate AP Invoice actions. 

 
The following scenarios cause a Sabrix Out-of-Tolerance hold to be placed on the invoice. When 

this happens, the Integration sets the Sabrix Tax Status descriptive flexfield (DFF) flag to O: 
 

• The supplier did not charge tax, but Determination determined there is a tax to charge. 

• Supplier overcharged tax and the tax is outside of the pre-defined tax tolerance. 

• Supplier charged tax for a transaction that Sabrix determined as a zero-rated or exempt 

transaction. 

 
To release holds, you can either make the necessary changes to the invoice and resubmit or 

cancel and request a new invoice from the supplier. 

 
See REPORTING (page 147) to learn about running the Sabrix AP Accrual Report to quickly 
generate a list of those invoices that are on hold. 
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The following example shows results of three tolerance and percent settings in the Difference 

Amount and Difference Percent rows: 
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OVERRIDE TOLERANCE SETTINGS FOR U.S. SALES AND USE TAX 

There may be times when you want to accept the Vendor Charged Tax amount instead of using 

the Determination calculated tax amounts. In order to accept the Vendor Charged Tax amount, you 

can override the eBTax: Sabrix Tolerance profile options by choosing one of the two following 

methods. 
 

• Accepting the Out of Tolerance Supplier Tax 

• Setting the US Out of Tolerance Hold 

 
Accepting the Out of Tolerance Supplier Tax 

The Sabrix Tax Status on the AP invoice distribution line descriptive flexfield (DFF) attribute values 

allow you to override the tolerance settings on an individual invoice. From the Sabrix Tax Status 

DFF list of values, select the status of A (Accept the Vendor Tax). When a distribution line of an 

invoice is marked with the status of A (Accept the Vendor Tax) , the invoice is processed as if it is 

in tolerance. 

 
To invoke this feature for U.S. Sales and Use Tax transactions, set the US Out of Tolerance Hold 

to review all invoices that have differences out of tolerance. 

 

Invoices with the status of A (Accept the Vendor Tax) are processed again by Determination and 

treated as if the difference was within tolerance. 
 

For transactions, Determination audits the Determination-calculated tax and places the vendor tax 

amount in the vendor_tax_amount audit field. 

 
Profile option eBTax: AP Sabrix Audit Determination Tax Amount only applies to non-U.S. 

transactions. 

 

Set the VCT distribution line to A (Accept the Vendor Tax) in order for the A (Accept the Vendor 

Tax) to have no accrual for a specific invoice. If a vendor does not charge tax, then create a zero 

VCT distribution line by using the Tax Details Summary form at the invoice header. Then go into 

Distributions forms and set the VCT distribution line DFF to A (Accept the Vendor Tax) if user 

wants to accept the zero tax amount and not have an accrual or expense line created by the 

Sabrix Tax Process. 

 
The VCT either entered at the invoice header Tax Control Amount or the Tax Details button will 

always override any calculated tax amounts from the AP on-line tax call. 

 

Then run the Sabrix Tax Process, which will not create any distribution lines as accrual or 

expense line when DFF status for VCT distribution line is set to A (Accept the Vendor Tax). If user 

wants an accrual and expense lines created by Sabrix Tax Process, then just set the zero VCT 

distribution line to 'R'. 

 
Merely marking only the item distribution line as A (Accept the Vendor Tax) will still create 

Sabrix accruals. 

 
Listed below are the scenarios of how to use the A (Accept the Vendor Tax) Accept functionality, 

and have no Sabrix accrual or expense lines created. 
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1. Enter VCT amount from the AP invoice using the Tax Details Summary form at the header 

and set Tax Only Line flag. Set the VCT distribution line DFF status to A (Accept the Vendor 

Tax). The item lines can still be left with the 'R' status. Then run Sabrix Tax Process and 

there are no accrual and expense lines & distribution lines created by the Sabrix Tax 

Process. 

2. Enter VCT amount from the AP invoice using the Tax Details Summary form at the header 

and set Tax Only Line flag. Set both the Item and VCT distribution lines DFF status to A 

(Accept the Vendor Tax). Then run Sabrix Tax Process and there are no accrual or expense 

lines or distribution lines created by the Sabrix Tax Process. 

3. If vendor did not charge tax and accruals should NOT be calculated on a particular invoice by 

Determination, then enter a zero VCT amount using the Tax Details Summary form at the 

header (Do not use the Control Total Amount at the header, accrual and expense lines are 

still created by Sabrix Tax Process) and set Tax Only Line flag. Set the VCT distribution line 

DFF status to A (Accept the Vendor Tax). The item lines can still be left with the 'R' status. 

Then run Sabrix Tax Process and there are NO accrual and expense lines & distribution 

lines created by the Sabrix Tax Process, since user accepted the VCT of zero. 

 
Setting the US Out of Tolerance Hold 

You can configure the Integration so you can review every transaction in which the difference 

between the supplier charged tax and the Determination calculated tax is outside of the configured 

tolerance. You can then decide how to handle the difference. 
 

The examples in this section assume the following configuration: 
 

• You have configured the Sabrix US Out of Tolerance Hold as described in the 

ONESOURCE Indirect Tax Integration for Oracle 12 Installation and Configuration Guide. 

• You have set your Profile Options as follows: 

 

 
Profile Option 

Example 
Value 

 
Comments 

eBTax:Sabrix AP Hold? Yes None. 

eBTax: Sabrix AP 

Tolerance Amount 

10 If the difference between vendor charged tax and 

Determination calculated tax is plus or minus $10.00 or less, 

no action will occur. 

eBTax: Sabrix AP 

Tolerance Percent 

5 If the difference between vendor charged tax and 

Determination calculated tax is 5% or less, no action will 

occur. 

eBTax: Sabrix 

Overcharge Shortpay 

Action 

Partial If the vendor charged tax is greater than the Determination 

calculated tax, the invoice will be shortpaid the difference so 

that the vendor is paid the Determination calculated tax. 

eBTax: Sabrix 

Undercharge Shortpay 

Action 

Off If the vendor charged tax is less than the Determination 

calculated tax, an accrual will occur to acknowledge the tax 

liability. 
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Three scenarios are described: 
 

• The vendor charged tax is greater than Determination calculated tax and out of tolerance. 

• The vendor charged tax is greater than Determination calculated tax and within tolerance. 

• The vendor charged tax is less than Determination calculated tax and out of tolerance. 

 
Scenario 1. Vendor Charged Tax is Greater Than and Out of Tolerance with Determination 

Calculated Tax. 
 

In this case, an AP invoice is entered and processed by the Sabrix Tax Process, but the 

difference between the vendor charged tax and the Determination calculated tax is greater than 

your tolerance settings. The invoice will have a Sabrix Invoice Hold and the invoice distributions 

will receive a status of O (Out of Tolerance). 
 

1. The invoice will appear on the Invoice on Hold Report, a standard Oracle E-Business Suite 

Report in Payables. 

2. You can then review the invoice and make one of these decisions: 

• Decide that a shortpay is required. Remove the hold and set the Tax Status Attribute back 

to R (Ready). Your next Sabrix Tax Process run will identify that you have removed the 

hold and mark it as T (Processed). The partial shortpay will be performed. 

• Decide that a new invoice is required from the supplier. The invoice can remain on hold until 

the corrected invoice is received. Then, cancel or credit as per your standard business 

process. 

• Decide the invoice will be paid as billed and no accrual is required for the tax difference. Set 

the tax status flags on the Vendor Charged Tax (VCT) distribution lines to A and release the 

hold. The invoice will be processed as if it is within tolerance. 

 
Scenario 2. Vendor Charged Tax is Greater Than and In Tolerance with Determination 

Calculated Tax. 
 

In this case, an AP invoice is entered and processed by the Sabrix Tax Process, but the 

difference between the vendor charged tax and the Determination calculated tax is within your 

tolerance settings. Integration does not place a hold on the invoice but marks the distribution lines 

with the letter T (Processed) to show that the invoice was processed, and the difference is within 

tolerances. 
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Scenario 3. Vendor Charged Tax is Less Than and Out of Tolerance with Determination 

Calculated Tax. 
 

An invoice is entered in AP and then processed by the Sabrix Tax Process. The difference 

between the vendor charged tax and Determination calculated tax is greater than your tolerance 

settings. The invoice will have a hold and the invoice distributions will receive a status of O (Out of 

Tolerance). 
 

The invoice will appear on the Invoice on Hold Report, a standard Oracle E-Business Suite report 

in Oracle Payables. 
 

Review the AP invoice and choose one of the following ways to handle the Out of Tolerance 

variances: 
 

• Decide that an accrual for the difference is required. Remove the hold and set the Tax 

Status Attribute back to R for ready. Your next Sabrix Tax Process run shows that you 

have removed the hold and mark it as T (Processed) and performs the accrual. 

• Decide that a new invoice is required from the vendor. The invoice can remain on hold until 

the corrected invoice is received. You can then cancel or credit per your normal business 

process. 

• Decide the invoice will be paid as billed and no accrual is required for the tax difference. Set 

the Tax Status flags on the Vendor Charged Tax (VCT) distribution lines to A and release 

the hold. This will treat the invoice as if the difference is within tolerance. 
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SETTING EBTAX: SABRIX AP WRITE DISTRIBUTIONS TO INVOICE? 

You can set the eBTax: Sabrix AP Write Distributions to Invoice? profile option to one of three 

choices to prevent the Integration from creating AP Miscellaneous lines and distributions for 

Determination calculated tax amounts. 
 

• YES writes lines to the AP_DISTRIBUTION table to create invoice Miscellaneous lines and 

distributions for U.S. Sales and Use Tax Accruals. 

• NO suppresses creating Miscellaneous lines and distributions for U.S. Sales and Use Tax 

Accruals on the AP transaction by not writing lines to the AP_DISTRIBUTION table. The tax 

amount is audited in Determination as usual. 

 
 

When profile option value is set to NO, the AP Invoice Distribution DFF attribute for Sabrix Tax 

Status will be updated with a “T” but the AP invoice distribution DFF attribute for Sabrix Tax 

Rate/Amount will be null and contain no tax rate or amounts. 

 
• EXCLUDE behaves like No for VAT self-assessments only as these AP lines could be 

considered extraneous if they use the same accounting for Determination AC, RC and IM 

Tax Types. All other transactions are treated like Yes. 

 
EXCLUDE value and the associated value set SBX_TAX_TYPES_TO_EXCLUDE is no longer 

applicable for non-U.S. transactions and will be deprecated in a future release. 

 
 
 
 

See ONESOURCE Indirect Tax Determination Online Help for more information about Tax Types. 
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If you choose EXCLUDE, the Integration does not write distributions for Tax Types of AC, RC, and 

IM. These choices can be modified by using the following instructions. 

 
EXCLUDE value and the associated value set SBX_TAX_TYPES_TO_EXCLUDE are no longer 

applicable for non-U.S. transactions and will be deprecated in a future release. 

 
 

To modify the information: 
 

1. Navigate to Setup > Flexfields > Validation > Values. 

2. Query SBX_TAX_TYPES_TO_EXCLUDE. 
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3. Note that the three Enabled tax types (AC, IM, and RC) will be excluded from calculations.+ 
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4. If desired, uncheck the Enabled check box for a tax type. If you uncheck the Enabled check 

box, the tax types (in the example, IM and RC) will be included in calculations. If you want to 

exclude an additional tax type, add another row in this value set. 
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ORACLE PROJECT ACCOUNTING 

Although the Integration does not integrate directly with Oracle’s Project modules, it can send tax 

distributions to Oracle Projects from Payables. Oracle standard functionality associates AP 

distributions with projects. Integration-created expense distribution lines also are associated with 

projects. 
 

You can enable this functionality by setting the profile option called eBTax: Sabrix AP Tax 

Grouping Rule. When you set the value to PROJECT, then the Integration provides project 

information that is entered on an AP invoice onto the appropriate Integration generated tax 

distribution lines. 
 

If you do not want to capture Project Accounting information, then use either the default grouping 

by tax code information (DEFAULT), or by custom rules (CUSTOM). 

 
See the section “Driving Project Accounting Using Custom Attributes” in the chapter “Post 

Installation: Technical Topics” of ONESOURCE Indirect Tax Integration for Oracle 12 Installation 

and Configuration Guide. 

 
Sabrix-generated short pay entry lines are created based on the short pay action described in 

PROFILE OPTIONS FOR SHORTPAY AND/OR ACCRUE (page 29). The general ledger 

account for the short pay lines is the same as the manual tax line. The project information for the 

short pay line is based on the associated tax line. If no manual tax line exists on the invoice, the 

general ledger accounts are derived based on the profile option eBTax: Sabrix AP Tax Expense 

Account Source. See Setting the eBTax: Sabrix AP Tax Expense Account Source 

Profile Option (page 23) for more information. 

 
In order to roll up the various expenses by project information, enter the following project related 

fields (defined in Projects) on the AP Invoice Distribution line: 
 

• Project Name 

• Task Number 

• Expenditure Type 

• Expenditure Org 

• Expenditure Item Date 
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ORACLE PROJECT ACCOUNTING 

 

 
The following sample invoice has multiple project tasks. When the Sabrix Tax Process is 

completed, each expense line was represented on each project line, while the accrual line for 

those same projects was rolled up under one line to the first item line. 
 

 
 
 
 

 
 
 
 
 
 
 

The concurrent program Sabrix Tax Process is only applicable to U.S. Sales and Use 

Tax. This is due to ONESOURCE Indirect Tax Integration for Oracle 12 Version 5.6.0.0 

enhancing the P2P functionality for real time (online) tax calculations for recoverable tax 

details. 
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SETTING EBTAX: SABRIX AP SKIP FULLY PAID U.S. INVOICES 

Business requirements determine whether a fully paid AP invoice should be processed by the 

Sabrix Tax Process. Setting the profile option eBTax: Sabrix AP Skip Fully Paid U.S. Invoices 

determines if AP invoices that are Paid in Full will be skipped. This would cause fully paid AP 

invoices to not be selected for processing by the AP Sabrix Tax Process. 
 

When an invoice is Paid In Full and the profile option is set to Yes, the AP distribution line 

descriptive flexfield (DFF) attribute for Sabrix Tax Rate/Amount displays Not processed due to 

invoice being fully paid. The allowable settings for the profile option will be Yes, No, and a null 

setting value, which will default to the behavior of No. 
 

1. Set the profile option eBTax: Sabrix AP Skip Fully Paid U.S. Invoices to Yes. 

2. Enter AP Invoice and validate with DFF status as R. 

3. Pay the AP Invoice for the full Amount. 

4. Run the Sabrix Tax Process. The fully paid invoice will be in the list of values in the request 

parameters. 

5. The invoice will be skipped by the Sabrix Tax Process and the distribution line descriptive 

flexfield attribute Sabrix Tax Rate/Amount will be updated with the message Not processed 

due to invoice being fully paid. 
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PURCHASING TAX CALCULATIONS 

 
 

This chapter reviews common Purchasing tasks and shows several scenarios in which the 

ONESOURCE Indirect Tax Determination-calculated tax is returned through the Integration: 
 

• PURCHASE REQUISITION TRANSACTIONS (page 59) 

• SINGLE-LINE PURCHASE ORDER TRANSACTIONS (page 61) 

• MULTIPLE SHIP-TO LOCATIONS ON A PURCHASE ORDER (page 66) 

 
The following flow charts show the requisition and purchasing processes and how the data is sent 

to and processed by the Integration: 
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PURCHASE REQUISITION TRANSACTIONS 

 

 

PURCHASE REQUISITION TRANSACTIONS 

A requisition created in Oracle Purchasing invokes a call to the Integration and ONESOURCE 

Indirect Tax Determination via Oracle E-Business Tax upon saving the requisition. Tax is then 

returned to the requisition from Determination and the Integration. In this scenario, the user enters 

the requisition information, including Item Number (or category/description), Quantity, 

Organization, Location (ship to), and Supplier Site (ship from) fields: 
 

1. Navigate to your requisition entry responsibility and enter the requisition header information. 

Depending on your set up of Oracle Purchasing, other fields may default or berequired. 

2. Enter line information, including Item, Quantity, and Need-By date. 

3. Enter Destination and Source information including Organization, Location (ship to), 

Supplier and Supplier Site (ship from). The Location (ship to) and the Supplier Site(ship 

from) information is required for the Integration and Determination to calculate and return 

tax. 

4. Save the Requisition. The Integration and Determination are invoked and tax is returned to 

the Requisition. 
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PURCHASE REQUISITION TRANSACTIONS 

 

 
5. To view tax details for the Requisition navigate to the menu bar Tools > Manage Tax. The 

example below is specific for U.S Sales and Use Tax which is a Nonrecoverable Tax. 
 

 
 

For non-U.S. transactions, such as VAT, the applicable tax amounts will be populated in the 

appropriate Nonrecoverable Tax or Recoverable Tax fields. 

 

6. Continue to process the requisition according to your business processes, through approval 

and purchase order creation. 

 
Tax will not be calculated on a purchase requisition sourced from Inventory (vs. Supplier sourced). 
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SINGLE-LINE PURCHASE ORDER TRANSACTIONS 

Some POs require only one item line. When the single-line PO is matched to an invoice in 

Payables, the appropriate Ship-To location from the PO Distribution Line will be used and the 

appropriate tax for that jurisdiction will be returned. 
 

In this scenario, the user enters a PO for a vendor including Ship-To, Ship-From, Item Number, 

and Quantity: 
 

1. Navigate to your Purchase Orders entry responsibility and enter the PO header information, 

including the Supplier, Supplier Site, and the Ship To. Depending on your set up of Oracle 

Purchasing, other fields may default or be required. 

2. Enter one line with an Item, Quantity, and Need-By date. 
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SINGLE-LINE PURCHASE ORDER TRANSACTIONS 
 

3. Navigate to the Shipments form and enter the Ship-To warehouse where the item will be 

shipped: 
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SINGLE-LINE PURCHASE ORDER TRANSACTIONS 
 
 

4. Navigate to the Distributions window and enter GL Account Distribution information if the 

item is a non-inventory item; otherwise, the GL Account Distribution information defaults from 

the inventory item. 
 

 
The Deliver-To address is not a factor in tax calculation. 

 
 

5. Save the Purchase Order. The Integration and Determination are invoked and tax is returned 

to the PO. 
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SINGLE-LINE PURCHASE ORDER TRANSACTIONS 
 

6. To view tax details for the Purchase Order, navigate to the menu bar Actions > Manage Tax. 
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SINGLE-LINE PURCHASE ORDER TRANSACTIONS 
 
 

7. Once you are in the Manage Tax form, click on Show under Details as shown below. The 

example below is specific for U.S Sales and Use Tax which is a Nonrecoverable Tax. 

 

 
For non-U.S. transactions, such as VAT, the applicable tax amounts will be populated in the 

appropriate Nonrecoverable Tax or Recoverable Tax fields. 

 

8. The Tax Detail Lines are now displayed. 
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MULTIPLE SHIP-TO LOCATIONS ON A PURCHASE ORDER 

Many purchase orders require that the merchandise be delivered to multiple locations for your 

company. The Integration provides functionality to meet this requirement. When a PO is matched 

to an invoice in Payables, the appropriate Ship-To location from the PO Distribution Line will be 

used and the appropriate tax for that jurisdiction will be returned. 
 

The following example shows that a quantity of a product is being shipped to WA, and another 

quantity is being shipped to CA. 
 

1. In the Shipments window, split the line into two different Ship-To locations. 

 
2. Enter any GL Account Distribution information required for each shipment line for non- 

inventory items, otherwise the GL Account Distribution will be defaulted from the inventory 

item. 
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MULTIPLE SHIP-TO LOCATIONS ON A PURCHASE ORDER 

 

 
3. Save the PO. 

4. View the tax by navigating to Actions > Manage Tax. The example below is specific for U.S 

Sales and Use Tax which is a Nonrecoverable Tax. 

 
 

For non-U.S. transactions, such as VAT, the applicable tax amounts will be populated in the 

appropriate Nonrecoverable Tax or Recoverable Tax fields. 
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VIEW TAX ON RECEIVING TRANSACTIONS 

Accounting information for inventory receipts against a purchase order can be viewed using the 

View Receipt Accounting form in Receiving. 
 

Navigate to the Receiving Transaction Summary. Select the receiving transaction for which you 

want to view accounting lines. Using the Tools menu, click Tools>View Accounting. The journal 

entries for the selected transaction will be displayed. The debit and credit amounts include tax 

amounts plus the price of the item, thus tax is included in the price of the item. 
 

See the Oracle Purchasing User’s Guide for more information. 
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PAYABLES TAX CALCULATIONS 

 
 

This chapter shows how the ONESOURCE Indirect Tax Integration for Oracle 12 interacts with 

Oracle Payables: 
 

• PROCESSING ORACLE PAYABLES USING THE ONESOURCE INDIRECT TAX 

INTEGRATION (page 70) 

• PAYABLES ONLINE TAX CALCULATION AND SABRIX TAX PROCESS (page 72) 

• VALUE ADDED TAX (VAT) TRANSACTIONS (page 74) 

• SUPPLIER VAT REGISTRATION NUMBERS (page 91) 

• PO MATCHING (page 97) 

• MANUAL INVOICING (page 104) 

• TRUSTED VENDOR TAX HANDLING FOR U.S. SALES AND USE TAX (page 105) 

• SABRIX TAX PROCESS FOR AP U.S. SALES AND USE TAX (page 107) 

• CANCELLING INVOICES (page 114) 

• DEBIT MEMOS (page 116) 

• REVERSING (page 117) 

• WORKING WITH FIXED ASSETS (page 118) 
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PROCESSING ORACLE PAYABLES USING THE ONESOURCE INDIRECT TAX INTEGRATION 

 

 

PROCESSING ORACLE PAYABLES USING THE ONESOURCE 
INDIRECT TAX INTEGRATION 

The following chart illustrates the basic payables process, and shows how the data is sent to 

Determination and processed by the Integration: 
 

 

 
 

Be sure to Save the tax distribution line, or click on Calculate Tax button or Tax Details button 

instead of just going directly to the Oracle Validate Invoice functionality as shown above in the 

process flow. 
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PROCESSING ORACLE PAYABLES USING THE ONESOURCE INDIRECT TAX INTEGRATION 

 
 
 
 
 

If transactions are processed for non-U.S. transactions, see the messaging under NON-U.S. 

TRANSACTIONS (page 73) section. 

 
 
 

The concurrent program Sabrix Tax Process is only applicable to U.S. Sales and Use 

Tax. This is due to ONESOURCE Indirect Tax Integration for Oracle 12 Version 5.6.0.0 

enhancing the P2P functionality for real time (online) tax calculations for recoverable tax 

details. 
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PAYABLES ONLINE TAX CALCULATION AND SABRIX TAX PROCESS 

 

 

PAYABLES ONLINE TAX CALCULATION AND SABRIX TAX PROCESS 

 
ONLINE TAX CALCULATION 

The eBTax call from Payables (AP) makes a full online tax calculation. The online tax calculation is 

invoked at events such as when saving the AP distribution line, validating the transaction, using 

the Calculate Tax button or the Tax Details button on the AP workbench. ONESOURCE Indirect 

Tax Determination will calculate tax and return the results to the AP transaction, creating Tax lines. 

The online tax calculation will return Tax to Rate Flow information for the ERP Tax Code, using the 

authority Tax to Rate flow for that ERP Tax Code. 

 
For more information on Authority Tax Flows and Source Tax Flows, see the ONESOURCE 

Indirect Tax Integration for Oracle 12 Installation and Configuration Guide. 

 
The AP online tax calculation is applicable to any non-U.S. transaction taxes like VAT, as well as 

for U.S. Sales and Use Tax transactions. 
 

• For non-U.S. transactions like VAT, the online tax calculation provides these types of 

transactions to be properly taxed. The AP transactions will display real time tax recoverable 

and nonrecoverable tax details. The online tax calculation eliminates the need for a 

concurrent process to handle recoverability and utilizes the ONESOURCE Indirect Tax 

Determination real time audit capabilities. For more information, see VALUE ADDED TAX 

(VAT) TRANSACTIONS (page 74). 

• For U.S. Sales and Use Tax transactions, the online tax calculation provides tax 

calculations, but does not utilize the ONESOURCE Indirect Tax Determination real time 

audit capabilities. Plus, additional processing is required to record differences between 

vendor charged tax (VCT) and ONESOURCE Indirect Tax Determination calculated tax 

amounts from the online tax calculation. For further information, see PROFILE OPTIONS 

FOR SHORTPAY AND/OR ACCRUE (page 29). 

 
 

The Sabrix Tax Process is only applicable to U.S. Sales and Use Tax. This is due to 

ONESOURCE Indirect Tax Integration for Oracle 12 Version 5.6.0.0 enhancing the P2P 

functionality for real time (online) tax calculations for recoverable tax details. 
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SABRIX TAX PROCESS CONCURRENT PROGRAM 

 
U.S. SALES AND USE TAX TRANSACTIONS 

For U.S. Sales and Use Tax processing, there is functionality provided by ONESOURCE Indirect 

Tax Integration to properly record differences between vendor charged tax (VCT) and 

ONESOURCE Indirect Tax Determination calculated tax amounts. 
 

• In order to use the ONESOURCE Indirect Tax Integration U.S. Sales and Use Tax shortpay 

and/or accrual functionality, additional processing is required to record differences between 

vendor charged tax (VCT) and ONESOURCE Indirect Tax Determination calculated tax 

amounts from the online tax calculation. 

For further information, see PROFILE OPTIONS FOR SHORTPAY AND/OR ACCRUE 

(page 29). 

 
• The concurrent program, Sabrix Tax Process is required for U.S. Sales and Use Tax 

transactions to properly update the transaction details in the ONESOURCE Indirect Tax 

Determination audit tables. 

 

The Sabrix Tax Process will summarize the calculated amounts by ERP Tax Code and use the 

‘Source’ Tax to Rate Flow for the ERP Tax Code. The resulting entries will have a line type of 

Miscellaneous and use the ‘Source’ tax flow information in the Tax Classification field. This 

‘Source’ tax flow is used to derive the tax expense account (if the profile option ‘eBTax: Sabrix AP 

Tax Expense Account Source’ is set to ‘TAX’). Otherwise if the tax expense account is null on the 

‘Source’ tax flow and profile option is not set to ‘Tax’, then the item line GL account will be used as 

the Tax Expense GL account. 

 
For details on how to run the concurrent program, see SABRIX TAX PROCESS 

CONCURRENT PROGRAM (page 73). 

 
NON-U.S. TRANSACTIONS 

 
Non-U.S. transactions like VAT have already been processed by the online tax calculation. But if 

the concurrent program, Sabrix Tax Process is run for non-U.S. transaction, there will be no 

additional processing of the non-U.S. transactions. The Invoice Distribution will be marked with a 

completed “T” status and be populated with “Processed by online tax calculation” in the Sabrix Tax 

Rate/Amount DFF attribute as shown below. 
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VALUE ADDED TAX (VAT) TRANSACTIONS 

To enable compliance with VAT laws, the Integration for Oracle 12 Procure to Pay provides 

a way to classify tax charges as fully, partially, or non-recoverable for self assessed or vendor 

charged tax (VCT) invoices when you calculate tax on the invoice or validate the invoice. 

The following scenarios demonstrate the results of processing invoices for both vendor charged 

tax invoices and self-assessed invoices. 

 
KEY CONFIGURATIONS FOR VAT TRANSACTIONS 

• The Profile Option “eBTax: Sabrix AP Audit Online Tax Calc” needs to be set to Yes. 

Setting this profile to yes will allow the ONESOURCE Determination audit tables to store 

the transaction information required for analysis, reporting and filing. See the 

ONESOURCE Indirect Tax Integration for Oracle 12 Installation and Configuration Guide for 

more information regarding this profile option. 

• ONESOURCE Indirect Tax Determination Company Option: Post VAT Non-recoverable 

Amount can be set in 2 different ways. The recommended set up should be No. See 

INPUT VAT RECOVERABILITY (page 125) section of the ENABLING ONESOURCE 

INDIRECT TAX DETERMINATION FEATURES (page 121) chapter for more details. This 

has examples of how the transaction appears when this company option is set to Yes and 

No. 

 
 

     The EXAMPLE VAT TRANSACTIONS (page 75) have the recommended set up as No. 

 
• Tax to Rate Flows must have Recoverable Rates associated to them and the output tax rate 

codes should have expense account filled in with the Output VAT GL account. For details, 

please see RECOVERY TAX RATE CODES FOR TAX TO RATE FLOWS (page 129) and 

SABRIX ADD ACCOUNT TO TAX RATE CODE (page 132). 

 

 
The concurrent program Sabrix Tax Process is only applicable to U.S. Sales and Use 

Tax. This is due to ONESOURCE Indirect Tax Integration for Oracle 12 Version 5.6.0.0 

enhancing the P2P functionality for real time (online) tax calculations for recoverable tax 

details. 

 
 

If the Tax Rate Code General Tax Accounts for Tax Expense is null, and the vendor 

charged tax is entered on the Tax Detail Summary as a Tax Only line, then GL Tax 

Expense Account is required. The Tax Only Line means the tax is not associated to an 

item line, therefore GL Tax Expense accounts cannot be determined when GL Tax 

Expense account is null on the Tax Rate Code. This is based on standard Oracle 

functionality to derive the GL Expense account from an item line if it is null on the Tax 

Rate Code. Integration is also using the same functionality to use the item line GL 

account if the Tax Rate Code has a null GL Tax Expense account. 
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EXAMPLE VAT TRANSACTIONS 
 

The following scenarios describe the results of VAT transactions when the vendor charges the 

correct tax on an invoice. 

 
Fully Recoverable Value Added Tax 

 
The Integration for Oracle 12 Procure to Pay automatically provides the Recoverable Tax results 

on your AP invoice Tax Line when you save the tax distribution line, click the Calculate Tax button, 

or click the Tax Details button before using the standard Oracle process to validate the AP 

transaction. 

 
Enter your invoice header information per your standard business process, but do not enter 

anything in the Tax Control Amount. 

Example: Enter invoice header with 1200 for invoice total and enter your invoice line and 

distribution for 1000 and then Calculate Tax and Validate the invoice. 

The online tax call will check Determination for the tax result and generate tax lines and 

distributions on the invoice. 

 
The tax amount calculated by Determination can be seen when you review the invoice lines and 

distributions as follows. Notice that the full tax amount is on the Recoverable Tax Distribution. 
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Nonrecoverable Value Added Tax 
 

The Integration for Oracle 12 Procure to Pay automatically provides the Nonrecoverable Tax 

results on your AP invoice Tax Line when you save the tax distribution line, click the Calculate Tax 

button, or click the Tax Details button before using the standard Oracle process to validate the AP 

transaction. 

 
Enter your invoice header information per your standard business process, but do not enter 

anything in the Tax Control Amount. 

Example: Enter invoice header with 1200 for invoice total and enter your invoice line and 

distribution for 1000 and then validate the invoice. 

The online tax call will check Determination for the tax result and generate tax lines and 

distributions on the invoice. 

 
The tax amount calculated by Determination can be seen when you review the invoice lines and 

distributions as follows. Notice that the full tax amount is on the Nonrecoverable Tax distribution. 
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Partially Recoverable Value Added Tax 
 

For transactions that have partially recoverable amounts, the Integration separates tax lines 

for Recoverable and Nonrecoverable tax amounts on the tax distribution lines. 

 
The tax amount calculated by Determination can be seen when you review the invoice lines and 

distributions as follows. Notice that the tax amount is split on the Recoverable and Nonrecoverable 

Tax distribution. 
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In order to get the result on a single tax line as shown above, Determination must have 

the Company Option ‘Post VAT Non-Recoverable Amount’ to N. See INPUT VAT 

RECOVERABILITY (page 125) section of the ENABLING ONESOURCE INDIRECT 

TAX DETERMINATION FEATURES (page 121) chapter for more details. 
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SELF ASSESSED VAT TRANSACTIONS 
 

The following scenarios describe the results of VAT for self-assessed fully recoverable, 

nonrecoverable and partially recoverable transactions. 

 
Fully Recoverable Self Assessed Tax 

 
The online call to Determination will return separate tax lines with separate Tax Rate Codes for 

VAT Acquisition or Reverse Charge tax types to represent the Input and Output VAT. 
Like the standard VAT transactions example above, the Input tax line will have the full tax amount 
on the Recoverable tax distribution. The Output VAT line will place the full amount of the Output tax 

on the Nonrecoverable Tax distribution. 

 
Note that the accounting for the Output tax line will use the correct VAT Payable GL 

account configured on the Tax Code even though the distribution is labelled as 

Nonrecoverable. 
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When using the PO match functionality with inventory items, the GL accounts for tax 

default to the inventory item GL account. For those transactions and other VAT 

transactions which may not have the correct accounting for your company, you may want 

to use Oracle Payable Subledger Accounting functionality to update the accounting as 

needed. 
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Nonrecoverable Self Assessed Tax 
 

The online call to Determination will return separate tax lines with separate Tax Rate Codes for 

VAT Acquisition or Reverse Charge tax types to represent the Input and Output VAT. 
Like the standard VAT transactions example above, the Input tax line will have the full tax amount 
on the Non-Recoverable tax distribution. The Output VAT line will place the full amount of the 

Output tax on its Nonrecoverable Tax distribution as well. 

 
 

 
Note that the accounting for the Input Tax line is following the item distribution as we did 

not put a specific tax expense account to use for the input tax account. If you wish to 

designate a specific tax expense account on your transactions, please see Tax Rate 

Codes and General Tax Accounts section of this document. 

 
 

 
For additional information about which GL accounts to be setup for the Tax Rate Codes 

and Tax Recovery Rates for Input and OutPut Tax Direction for P2P Recoverable/Liability 

Accounts, see the ONESOURCE Indirect Tax Integration for Oracle 12 Installation and 

Configuration Guide Version 5.6.2.4 under the Gather Regime, Tax Code and Operating 

Unit Values section for the Regime to Rate Flow Parameters. 
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VALUE ADDED TAX (VAT) TRANSACTIONS 
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VALUE ADDED TAX (VAT) TRANSACTIONS 

 

Partially Recoverable Self Assessed Tax 
 

For transactions that have partially recoverable amounts, the Integration apportions the 

Recoverable amount and Nonrecoverable amount over the Tax Distributions associated with the 

Input VAT tax line. The output VAT line is still the same as the prior examples, the full amount of the 

tax is on the distribution labelled Nonrecoverable and uses the Output VAT GL Account. 
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VENDOR TAX HANDLING FOR VAT TRANSACTIONS 
 

One of the features of having ONESOURCE Indirect Tax Determination calculate the tax on your 

invoice is to capture vendor charged tax that may be incorrect. Below is a flowchart of how to work 

with a tax difference when using the online call. 

 

 

 
After you have Validated your invoice, if the online call returns a tax amount different than what the 

vendor charges, then the invoice will have a status of “Needs Revalidation” and have a Line 

Variance hold applied. Verify and correct the invoice details such as item purchased and Ship to 

address. If that doesn’t resolve the difference, the Vendor may have charged incorrect VAT. Per 

the guidelines of your tax department, decide if you will notify the vendor and wait for a corrected 

invoice or pay the vendor as billed by entering the Vendor charged tax in the Tax Control Amount 

field on the invoice header. 
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VALUE ADDED TAX (VAT) TRANSACTIONS 
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VALUE ADDED TAX (VAT) TRANSACTIONS 

 

USING TAX CONTROL AMOUNT ON VAT AP TRANSACTIONS 

When the Tax Control Amount is filled in, the Online tax call will create the tax lines and 

distributions with whatever amount is filled in. Therefore this must only be used when you want to 

force the VAT result to pay a vendor as billed. 

 
Example Using Tax Control Amount 

This example calculated tax of 200 and left the invoice out of balance. Entering a Tax control 

amount to match what the Vendor billed will look like this: 
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VALUE ADDED TAX (VAT) TRANSACTIONS 

 
 
 

 

This situation will occur when theTax Control Amount is filled in AND Determination calculated a 

tax amount other than Zero. 
 

1. The original calculated tax line will be reversed. 

2. A new Tax Line will get created. It will use the Determination calculated rate but it will also 

update the Tax Amount to match the value in Tax Control Amount field. 

3. It will update the “Taxable Amount” on the Tax Detail Tab. This is not used by Determination. 

4. Determination audits the calculated tax result and will also send the Tax Control Amount 
value to the vendor_tax data element and the Determination calculated tax to the 

tax_amount data element in Determination Audit if the profile option eBTax: AP Sabrix 

Audit Determination Tax Amount is set to Yes. If the profile option is set to No, then the 

Determination calculated tax will be saved in both vendor_tax and tax_amount audit fields. 

This can be viewed in the Transaction Extract in ONESOURCE Reporting. 

5. The line variance hold will automatically be removed when the invoice is revalidated. 
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VALUE ADDED TAX (VAT) TRANSACTIONS 

 

Example Using Tax Control Amount when Determination calculates Reverse 

Charge 

If Determination has identified the transaction should receive Zero Rate or Reverse charge, the net 

tax result is 0.00. In these situations, Oracle will not allow the Tax Control Amount to generate new 

tax lines. Instead you will receive a Tax Variance hold. As with any other Vendor tax difference, 

verify the invoice details and the configuration in Determination or ask the vendor for a corrected 

invoice. 
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VIEWING VENDOR CHARGE TAX IN ONESOURCE INDIRECT TAX REPORTING 
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SUPPLIER VAT REGISTRATION NUMBERS 

The supplier VAT registration numbers stored in Oracle at the party level and the party site level 

(for the site used on the transaction) are passed to Determination. Determination uses this 

information to determine if a transaction is eligible for taxation within a particular jurisdiction. If a 

registration does not exist and Determination concludes that one is required, an error message in 

the Sabrix Tax Process log indicates that one needs to be created. 
 

If a VAT registration does not exist, and Determination concludes that one is required, an error 

message will appear on your screen indicating that one needs to be entered in order to calculate 

tax. 

 

See ONESOURCE Indirect Tax Determination Online Help for more information. 

 
When entering VAT Registration numbers in Oracle R12, note that Oracle performs hard-coded 

validation on registration numbers for 31 countries. The validation formula is different for each 

country. Review the Oracle code to determine the specific formula. The current list of countries 

includes: Austria, Belgium, Denmark, Estonia, Finland, France, Germany, Greece, Ireland, Italy, 

Luxembourg, Netherlands, Poland, Portugal, Slovakia, Spain, Sweden, Switzerland, United 

Kingdom, Russia, Hungary, Argentina, Chile, Colombia, Taiwan, Brazil, Malta, Cyprus, Latvia, 

Lithuania, Slovenia. 

See MyOracleSupport note 875894.1 for more information. 

 
 

 
To enter a VAT Registration on your Supplier Site, navigate to the Tax Information form from 

Oracle Payables, Oracle Purchasing or any other Oracle responsibility that has Supplier setup. 

The following steps are for accessing from Oracle Payables. 
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1. Navigate to the Payables > Suppliers > Entry Search screen. 

2. Enter a portion of an existing Supplier Name and click Go. 
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3. Once you have the results, click the Update icon on the Supplier Name. 
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4. On the left side of the form, go to Company Profile for Tax Details. Then click the Update 

Transaction Tax icon for a specific Site Name. 
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5. Click Create. 
 

 
6. Enter the Tax Regime Code, Tax Registration Number, and Effective From date. If 

necessary, enter the Tax and Jurisdiction to make a unique combination. 
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7. Click Apply and then click Save. 

8. The Warning page shows a message: Changes to Tax Details have been saved. 
 

 

MULTIPLE VAT REGISTRATION NUMBERS 

In some cases a single location may need to file multiple registrations. A separate tax registration 

number can be defined to represent each distinct registration requirement. Oracle requires the 

registration number be unique for the combination of Regime, Tax, and Jurisdiction. 
 

• Regime - registration number applies to all the taxes within a regime. For example, a 

registration number applies to the all the taxes for Canada. In this case, a registration 

number would be defined for the Canada Regime. 

• Tax - registration number applies to all the jurisdictions where the tax is applicable. For 

example, a registration number applies to all the jurisdictions under the tax for Canada 

Province of Quebec. In this case, a registration number would be defined for the Canada 

Regime and tax of QCQST. 

• Jurisdiction - registration number applies to the specific jurisdiction. The registration number 

can be defined using the jurisdiction to make the combination unique. 
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PO MATCHING 

The PO match process is used when you enter an invoice with a purchase order associated with it. 

When an invoice is matched, information needed by the Integration is obtained from the purchase 

order. 
 

Companies match invoices to purchase orders according to their standard business processing 

guidelines. This example shows the effects of the tax calculation when the tax on the vendor 

invoice matches the tax determined by Determination. 

 
Other AP Invoice examples in this document have not been matched to Purchase Orders. 

 
 

1. Navigate to the Accounts Payable Invoice Entry form. Enter the required invoice information 

shown on this screen according to your company’s standard business processes. 

2. For U.S. Sales and Use Tax invoices, enter the invoice amount of vendor charged tax into 

the Tax Control Amount field. For VAT invoices the online tax call will create the tax line. 

Do not enter a Tax Control Amount. Please see Vendor Tax Handling for VAT 

Transactions (page 85) for more detail. 

3. From the invoice header, click Match. 
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4. Match the PO to an invoice using your standard business matching process. 
 

 
5. When you return to the invoice line form, the Invoice Total Gross displays the amount of the 

PO lines created by the matching process. Click Distributions for the first PO matched item 

line. 

 
6. For PO Matched invoices, the Ship To Address will be derived from the PO and defaulted 

on the AP invoice line. The Ship To Address can be changed after it is derived from the PO. 

Ship To address is not required for either non-PO matched AP invoices or PO matched AP 

invoices. If Determination has insufficient information to calculate tax and does not return any tax 

lines, the SABRIX_LOG table will display the following ERROR Message: “No tax lines were 

returned from ONESOURCE Indirect Tax Determination. Contact your Determination tax 

administrator”. 
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7. If this is a known VAT invoice, there is no need to proceed further. Otherwise, enter R in the 

Sabrix Tax Status descriptive flexfield on the AP Distributions form (shown below) to 

indicate the invoice is ready for processing through the Sabrix Tax Process. 

 

If you are importing invoices using the Oracle AP Open Interface and you want to copy the Sabrix 

descriptive flexfields (DFF) information to the AP Invoice Distribution Lines, the Oracle System 

Options Profile Option AP: Copy Invoice Lines Flex field to Distributions during Import must 

be set to Yes. 

 
You can configure the Sabrix Tax Status descriptive flexfield segment with a constant value of R 

as a default. This will default R upon saving the manual invoice. 

To default the status R for PO Matched Invoices, define the Oracle Purchasing descriptive flexfield 

‘PO Distributions’ with the same attribute number as the Oracle Payables descriptive flexfield 

segment, AP_SABRIX_TAX_STATUS. Then set the constant value of R as a default on the PO 

Distributions descriptive flexfield. Set the profile option AP:Copy Invoice Lines Flexfield to 

Distribution during Import to Yes. This will default the status R when matching the AP invoice to 

the PO. 

 
8. Click OK. 
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9. Click Tax Details to view the prorated vendor charged tax amount which was entered into 

the Tax Control Amount field at the invoice header. 
 

 
 

 
An online tax calculation is invoked at events such as when Saving the distribution line, Calculate 

Tax button or the Tax Details button on the AP workbench. Determination will calculate tax and the 

Integration will return the results to the AP invoice, creating Tax lines. Any differences between the 

PO calculated tax and the AP Invoice online tax calculation will result in Tax Rate Variance lines. 

The online tax calculation will return Tax to Rate Flow information for the ERP Tax Code, using the 

authority Tax to Rate flow for that ERP Tax Code. 
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10. In the Tax Lines Summary form, the online calculated tax will be based on prorating the Tax 

Control Amount with the appropriate Authority Tax Rate percentages. 
 

 

11. The following table is an example of the information displayed on the Tax Details Summary 

form: 
 

Tax Lines 
Summary Field 
Name 

 
Example 
Values 

 

 
Example of Your Values 

Tax Regime Code SBX_REGIME_US SBX_REGIME_XX 

XX = ISO two digit Country Code 

Tax USWA_P2P_439 

USWA_P2P_138 

USWA_P2P_440 

<ERP Tax Code>_P2P_XXXXX 

XXXXX = database-generated incremental number 

Jurisdiction WA - STATE SALES/USE 

TAX 

WA - REGIONAL 

TRANSIT AUTHORIT 

WA - SEATTLE, CITY 

SALES/USE T 

This will be the actual authority from Determination 

for each Tax Line Number. 

Example: For USWA (State of Washington), there are 

usually three authorities for one ERP Tax Code such 

as: 

• WA - STATE SALES/USE TAX 

• WA - SEATTLE, CITY SALES/USE T 

• WA - REGIONAL TRANSIT AUTHORIT 

Notes: 

• The display size is limited to 30 characters. 

• The field does not show as Required on the Tax 

Details Summary form, but the value is needed in 

order to enter a Tax Amount. 
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Tax Lines 
Summary Field 
Name 

 
Example 
Values 

 

 
Example of Your Values 

Tax Status USWA_P2P_439 

USWA_P2P_138 

USWA_P2P_440 

<ERP Tax Code>_P2P_XXXXX 

XXXXX = database-generated incremental number 

Rate Name USWA_P2P_439 

USWA_P2P_138 

USWA_P2P_440 

<ERP Tax Code>_P2P_XXXXX 

XXXXX = database-generated incremental number 

Rate 6.50% USWA_P2P_439 for WA - STATE SALES/USE TAX 

0.00% USWA_P2P_138 for WA - SEATTLE, CITY 

3.00% SALES/USE T 

 USWA_P2P_440 for WA - REGIONAL TRANSIT 

 AUTHORIT 

Tax Amount 68.42 Tax Control Amount of $100.00 is prorated based 

0.00 

31.58 

upon the various Rate %s for the appropriate 

authorities. 

$100.00 x 65/95 = 68.42 

 $100.00 x 00/95 = 0.00 

 $100.00 x 30/95 = 31.58 

 

12. Click OK and save the AP Invoice. 

13. When the AP Invoice is complete, validate it according to your company’s standard business 

processes. The AP Invoice must be validated in order for the Sabrix Tax Process to select 

the invoice for processing. 
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If Vendor Charged Tax has been entered (as in this example) for U.S. transaction in the Tax Control 

Amount field, the online tax calculation will use the tax rates returned from Determination to prorate 

the VCT into tax lines. The Vendor Charge Tax entered in the Tax Control Amount field overrides 

the standard online tax calculated amounts. If there is no Vendor Charged Tax, the online tax 

calculation creates Tax Lines with the tax amount calculated based only on the Item line amounts. 
 

14. Run the Sabrix Tax Process. Requery the AP Invoice to see the Integration-generated 

lines. See SABRIX TAX PROCESS FOR AP U.S. SALES AND USE TAX (page 107) for 

more information. 

 

 
 

The Sabrix Tax Process for the U.S. transaction will recalculate tax, perform the accrual logic, and 

submit the transaction to Audit. The Sabrix Tax Process will summarize the calculated tax amounts 

by ERP Tax Code and use the ‘Source’ Tax to Rate Flow for the ERP Tax Code. The entries (either 

due to the accrual logic or if zero dollar Vendor Charge Tax is entered) will have a line type of 

Miscellaneous and use the ‘Source’ Tax Flow information in the Tax Classification Code field. This 

'Source' tax flow is used to derive the recoverable/liability account and the tax expense account (if 

the profile option, 'eBTax: Sabrix AP Tax Expense Account Source' is set to 'TAX'). For more 

information on Source Tax Flows, see the ONESOURCE Indirect Tax Integration for Oracle 12 

Installation and Configuration Guide. 

 
 
 
 

 
The concurrent program Sabrix Tax Process is only applicable to U.S. Sales and Use 

Tax. This is due to ONESOURCE Indirect Tax Integration for Oracle 12 Version 5.6.0.0 

enhancing the P2P functionality for real time (online) tax calculations for recoverable tax 

details. 



103 PAYABLES TAX CALCULATIONS 

ONESOURCE INDIRECT TAX INTEGRATION FOR ORACLE 12 

PROCURE TO PAY USER’S GUIDE - VERSION 5.6.2.4 

 

 

MANUAL INVOICING 

 

 

MANUAL INVOICING 

Manually entered AP Invoices that are not matched to purchase orders follow a similar entry 

process as PO Matched invoices. To enter a manual AP Invoice not matched to a purchase order: 
 

1. Navigate to the Accounts Payable Invoice Entry form. Enter the required invoice information 

shown on this screen according to your company’s standard business processes. 

2. Navigate to the Lines tab. Enter the invoice line information. 

3. For U.S. Sales and Use Tax invoices, enter the invoice amount of vendor charged tax into 

the Tax Control Amount field. For VAT invoices the online tax call will create the tax line. 

Do not enter a Tax Control Amount. Please see Vendor Tax Handling for VAT 

Transactions (page 85) for more detail. 

4. The Ship To Address can be left blank. 

The value in the Ship to address field on the manually entered AP invoice line is not required for 

online tax calculation or the Sabrix Tax Process. When matching an AP invoice to a PO, the Ship 

To address automatically defaults from the matched PO Ship To. 

• If Determination has insufficient information to calculate tax and does not return any tax 

lines, the SABRIX_LOG table will display the following ERROR Message: “No tax lines 

were returned from ONESOURCE Indirect Tax Determination. Contact your Determination 

tax administrator”. 

 
5. Click the Distributions button for the item line and enter the Distribution information. 

6. If this is a known VAT invoice, there is no need to proceed further. Otherwise, enter R in the 

Sabrix Tax Status descriptive flexfield to indicate the invoice is ready for processing. 

The Sabrix Tax Status descriptive flexfield segment can be configured with a constant value of R 

as a default. This will default R upon saving the manual invoice. This is acceptable for VAT invoices 

as well. VAT invoices will not be reprocessed but will simply be marked with a “T” as Processed, 

along with the phrase “Processed by online tax calculation.” 

 
7. When the AP Invoice is complete, validate the AP Invoice according to your company’s 

standard business processes. The AP Invoice must be validated in order for the Sabrix Tax 

Process to select the invoice for processing. 

8. Run the Sabrix Tax Process. See SABRIX TAX PROCESS FOR AP U.S. SALES AND 

USE TAX (page 107) for more information. 

9. To account for the AP invoice, run the Oracle standard process to Create Accounting 

according to your company’s standard business processes. 

 

 
The concurrent program Sabrix Tax Process is only applicable to U.S. Sales and Use 

Tax. This is due to ONESOURCE Indirect Tax Integration for Oracle 12 Version 5.6.0.0 

enhancing the P2P functionality for real time (online) tax calculations for recoverable tax 

details. 
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TRUSTED VENDOR TAX HANDLING FOR U.S. SALES AND USE TAX 

Business requirements drive the decision for handling tax variances between the vendor charged 

tax and the Determination-calculated tax. This section is not applicable for any non-U.S. 

transactions such as VAT. 

 
ALLOWING TRUSTED VENDORS 

Your business may have relationships with vendors who always charge the correct amount of 

vendor charged tax on their AP invoices. In order to not have the tax accrued or shortpay the 

vendor, the vendor charged tax (VCT) will be always used as the tax amount. The Determination- 

calculated tax rates will be stored in Audit for reporting purposes. 
 

The tax calculation can be turned off for a specific Supplier Site in Oracle. Thus tax will not be 

recalculated on these vendors designated as having a Trusted Vendor relationship with your 

business. 
 

When the Oracle Supplier Site for ‘Calculate Tax’ field is set to No, the Sabrix Tax Process treats 

the invoice as “In-Tolerance” and will not shortpay or accrue any additional tax amounts on the AP 

invoice. The AP invoice will be processed “as-is” and the Sabrix Tax Rate/Amount descriptive 

flexfield (dff) displays a message “Trusted vendor site - Tax not re-calculated”. 
 

To turn off tax calculation for a specific Supplier Site in Oracle: 
 

1. Navigate to Supplier > Entry. 

2. Search for the Supplier. 

3. On the Suppliers tab, click on Tax And Reporting. 

4. Then go the the bottom of the Supplier form to Supplier Sites. 

5. Select a Supplier Site and then click on the Update Transaction Tax icon. 
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6. In the Supplier Site Tax Details region of form, go to Calculate Tax field set to No for the site 

selected for specific operating units 

 

 

 
7. Enter AP invoices for this supplier based on your company’s standard business processes. 

8. After the AP invoice is completed, validated and the Integration Sabrix Tax Process has 

completed with no errors, requery the AP invoice. View the AP item line distributions line for 

the Sabrix Tax Rate/Amount descriptive flexfield (dff) which displays the message “Trusted 

vendor site - Tax not re-calculated”. 

 
 
 

 
 
 

For U.S transactions, Determination audits the Determination-calculated tax as zero and places 

the vendor charged tax (VCT) amount in the vendor_tax_amount audit field. 
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SABRIX TAX PROCESS FOR AP U.S. SALES AND USE TAX 

This section describes the Sabrix Tax Process, how to run it, and the results. The Sabrix Tax 

Process has two Oracle concurrent processes: 

 
Sabrix Tax Process (Parent concurrent process). Gathers all invoices with lines ready to be 

processed and separates them into batches. Invoices are ready to be processed once they are 

validated and the AP Distribution Lines descriptive flexfield for Sabrix Tax Status attribute is set to 

R (Ready) or A (Accept). Then a Sabrix AP Tax Thread job is submitted for each batch of invoices. 

 
Sabrix AP Tax Thread (Child concurrent process). Pulls the required information from each 

eligible invoice line in order to determine the tax, processes the line, and then sets the AP 

Distribution Lines descriptive flexfield for Sabrix Tax Status attribute flag to: 
 

• T - indicates that the line has been processed by the Sabrix Tax Process. 

• E - indicates that the tax process encountered an error on that invoice. 

• O - indicates that the invoice is outside of tolerance. 

• C - indicates that the invoice was cancelled. See CANCELLING INVOICES (page 114). 

 
The eBTax: Sabrix Approve Invoices profile option determines whether the Sabrix Tax Process 

will process the invoice through the AP approval workflow (if enabled by your company). See the 

ONESOURCE Indirect Tax Integration for Oracle 12 Installation and Configuration Guide, 

“Configuring Profile Options” section for more information. 
 

The Sabrix Tax Process creates Miscellaneous Lines that reference the 'Source' tax flow in the 

'Tax Classification Code' field of the invoice line. This 'Source' tax flow is used to derive the 

recoverable/liability account and the tax expense account (if the profile option, 'eBTax: Sabrix AP 

Tax Expense Account Source' is set to 'TAX'). For more information on Source Tax Flows, see the 

ONESOURCE Indirect Tax Integration for Oracle 12 Installation and Configuration Guide. 

 
 

The concurrent program Sabrix Tax Process is only applicable to U.S. Sales and Use 

Tax. This is due to ONESOURCE Indirect Tax Integration for Oracle 12 Version 5.6.0.0 

enhancing the P2P functionality for real time (online) tax calculations for recoverable tax 

details. 
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SABRIX TAX PROCESS FOR AP U.S. SALES AND USE TAX 
 
 

To manually run the Sabrix Tax Process: 
 

1. From an Oracle Payables responsibility, navigate to the Submit Request form. 

2. In the Name field, select Sabrix Tax Process from the list of values. 

3. Select the Operating Unit from the list of values. 
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SABRIX TAX PROCESS FOR AP U.S. SALES AND USE TAX 

 

4. Enter information from the following table on the Parameters page: 
 

 
 
 

Parameter Description 

Invoice Number • Enter an invoice number to process an individual invoice. 

• Leave this field blank to process all eligible invoices. 

Max Inv/Line per Worker • The default is 1000 invoices per worker. 

• See SETTING THE MAX INV/LINES PER WORKER 

PARAMETER (page 112) to determine the correct setting for 

your environment. 

Debug Level Enter one of the following: 

• ALL to write all debug messages. 

• OFF to not write messages. 

Invoice Batch Name • Enter an AP Invoice Batch Name to process an AP Invoice 

batch. This parameter is optional. 

• Leave this field blank to process all eligible AP invoicebatches. 

 
To view debug messages in the Sabrix Tax Process concurrent request log file, enter ALL in the 

request parameters (noted above). Alternatively, the debug level can be set to a value other than 

10 in the SABRIX_CONNECTION_OPTIONS table. See the ONESOURCE Indirect Tax 

Integration for Oracle 12 Installation and Configuration Guide, “Registering the ONESOURCE 

Indirect Tax Integration” section, for more information. 

 
5. Click OK and then Submit. 

Depending on the setting of the Max Inv/Line per Worker parameter and the quantity of eligible 

invoices, multiple Sabrix AP Tax Thread jobs may be submitted by the Sabrix Tax Process. Once 

the threads are submitted, the Sabrix Tax Process completes, as shown below. As long as the 

concurrent manager is available, the processes can run at the same time. The remaining jobs will 

be in pending status until the concurrent manager is available. 

 
To avoid overloading the concurrent manager, you should limit the number of concurrent jobs you 

submit. Set the Maximum Number of Workers profile option accordingly. You will need to run 

additional jobs to process the remaining invoices. 
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The Sabrix Tax Process will complete with an Error if ONESOURCE Indirect Tax Integration for 

Oracle 12 is not installed or setup for an Operating Unit. 

 
 
 
 

 

In the example above, the highlighted items show: 
 

1. The Sabrix Tax Process is running and has submitted multiple Sabrix AP Tax Threads. This 

job will complete only when all the threads have completed. 

2. The full field name is [Org 204] [4 of 4] Sabrix Tax Worker (Sabrix AP Tax Thread). 

Org 204 indicates which Org the job was submitted from. [4 of 4] indicates that 4 Sabrix AP 

Tax Thread jobs were submitted and that this is the last submission. 

3. The value in the Parent ID for each Sabrix AP Tax Thread is the concurrent request ID of the 

Sabrix Tax Process. This is true even if you include the Sabrix Tax Process in a Request 

Set. 

The Sabrix AP Tax Thread jobs can run concurrently, allowing parallel processing. As the 

concurrent manager becomes available, the remaining threads will run concurrently. 
 

The first two parameters for each Sabrix AP Tax Thread job show a range of invoice IDs for 

processing. The Sabrix Tax Process selected all eligible invoices and passed ranges of invoice 

IDs to allow parallel processing. 

 
This process can be scheduled using the standard Oracle Concurrent Request Scheduling 

functionality for reports and processes. 
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VIEWING THE RESULTS 

When the Sabrix Tax Process has completed, the AP Distribution Line descriptive flexfield for 

each item line distribution is updated with the results, including the Sabrix Tax Status flag, the 

Sabrix Tax Rate/Amount and any tax accrual or tax expense distribution lines and amounts. 
 

The AP Sabrix Item Link Distribution Line descriptive flexfield segment for the Sabrix 

Miscellaneous distribution lines shows the associated item line and distribution line numbers in the 

format <item>/<distribution>. The Sabrix Item Link attribute usually displays an associated item 

line link for the Sabrix Tax Accrual and/or Sabrix Tax Expense Miscellaneous Line Type. But in the 

case of a supplier overcharge and the eBTax: Sabrix Overcharge Shortpay Action profile option 

is set to OFF, the Sabrix Item Link attribute will display a (-1) for only the first item distribution line. 

 
For tax lines that result in multiple groupings of lines, the last line number is displayed. In the 

Distribution window of the invoice, navigate to the descriptive flexfield. The Sabrix Tax Status 

field has changed from R to T to indicate that the invoice line was processed by Determination. 

When the Sabrix Tax Process runs again, this line is not processed again. 

 
For examples of the results, see Default GL Accounts for Integration-Generated 

Miscellaneous Line Type (page 22) and Examples of AP Invoice Distribution Lines (page 

31). 

 
 

The concurrent program Sabrix Tax Process is only applicable to U.S. Sales and Use 

Tax. This is due to ONESOURCE Indirect Tax Integration for Oracle 12 Version 5.6.0.0 

enhancing the P2P functionality for real time (online) tax calculations for recoverable tax 

details. 



111 PAYABLES TAX CALCULATIONS 

ONESOURCE INDIRECT TAX INTEGRATION FOR ORACLE 12 

PROCURE TO PAY USER’S GUIDE - VERSION 5.6.2.4 

 

 

SABRIX TAX PROCESS FOR AP U.S. SALES AND USE TAX 

 

SETTING THE MAX INV/LINES PER WORKER PARAMETER 

To determine the optimal setting for the Max Inv/Lines per Worker parameter, consider the 

following questions: 

 
What is the invoice volume each time you run the Sabrix Tax Process? 

 
Example A: You run your Sabrix Tax Process once each evening and typically process 

about 5000 invoices per day. However, twice a month you receive an invoice import that 

spikes to about 11000 invoices per day. Typically, your invoices average about 3 lines per 

invoice. 

Example B: You run your Sabrix Tax Process every 4 hours and typically process about 50 

invoices with an average of 100 lines per invoice. 

 
How many jobs are available in your concurrent manager? 

 

Example A: You have a general concurrent manager that allows 10 jobs to run at the same 

time. The concurrent manager is used by all of Oracle Financials, so you do not want your 

tax process to take up more than 3 slots to minimize the impact to other processes. 

 
Example B: Due to your concurrent manager settings and use, only one Sabrix Tax 

Process can run at a time. In this case, you may not want to split your volume across 

separate Tax Thread jobs. 

 
How much time does it take to process an average invoice in your environment? 

 

You will need to determine this by testing the new Sabrix Tax Process in your environment. 

 
Are you constrained more by time for the processing to complete or availability of 

concurrent process slots? 
 

Example A: If you must process all invoices in a short window of time, you may want to 

maximize performance by having multiple threads running concurrently. 

 
Example B: If your concurrent manager has high demands on it at the time you must run 

your Sabrix Tax Process, you may decide that you want all of your eligible invoices to be 

processed in one batch and only have one tax thread submitted. Alternatively, you could 

decide to submit multiple tax threads. Even if they do not run concurrently, you will have 

multiple shorter running jobs. 

 
The following table shows the effects of using different values for the Max Inv/Lines per Worker 

parameter on concurrent process availability when processing 5000 invoices or 5000 lines. 

 
The profile option eBTax: Sabrix Batch by Lines defaults to group by invoices. Set this profile 

option to Yes to enable batching by lines. 
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If you are processing by lines, note that all lines on a single invoice must be processed by the 

same worker to ensure proper taxation of the whole invoice, so the distribution across several 

workers may not be equal. 

 

Eligible 
Invoices 
or Lines 

Max 
inv/Lines 
per Worker 

 
Number of Tax 
Threads Submitted 

Open 
Concurrent 
Spots 

 

 
Running 

 
Initially 
Pending 

5000 500 10 3 3 7 

5000 2000 3 3 3 0 

5000 1000 5 1 1 4 

 
Do not set the Max Inv/Lines per Worker parameter to a very low number when you have a large 

quantity of invoices to process. Doing so may overload your concurrent manager. For example, 

given a volume of 5000 invoices ready to process, setting this parameter to 5 would cause 1000 

separate submissions of the AP Tax Thread. To help manage this, you may set the profile option 

Maximum Number of Workers to reduce the impact of an inadvertent submission. 

 

CONFIGURING TAX PROCESS LOGGING AND XML SETTINGS 

The ONESOURCE Indirect Tax Integration provides flexible logging capabilities that are controlled 

by the following settings: 
 

• The Debug Level parameter in the Sabrix Tax Process and Sabrix AP Tax Thread 

concurrent jobs. 

• The Debug Level parameter on the Sabrix Tax Process concurrent process overrides 

the SABRIX_CONNECTION_OPTIONS table setting. 

• If the Sabrix Tax Process Debug Level parameter is null, then the 

SABRIX_CONNECTION_OPTIONS table debug_level setting will be used. 

• The values set for debug_level and log_file are in the SABRIX_CONNECTION_OPTIONS 

table. These values were entered during the Integration installation. 

• The eBTax: Sabrix Debug Level profile option controls what data is in the SABRIX_LOG 

table. This profile option does not affect the AP Sabrix Tax Process. 

 
The value set for log_file must be a fully qualified file name (for example, 

c:\temp\sabrix\connlog.log). 

 
Sources of Integration logging and message information are: 

 

• The concurrent log of the Sabrix AP Tax Thread. 

• The concurrent output of the Sabrix AP Tax Thread. 

• The SABRIX_MESSAGE table. 

• The SABRIX_LOG table. 



113 PAYABLES TAX CALCULATIONS 

ONESOURCE INDIRECT TAX INTEGRATION FOR ORACLE 12 

PROCURE TO PAY USER’S GUIDE - VERSION 5.6.2.4 

 

 

CANCELLING INVOICES 

 

 

CANCELLING INVOICES 

Invoices cancelled in Oracle must be updated in the audit to reflect the cancellation. Invoices 

previously processed by the Integration will be reversed in the audit. The invoice tax status flag on 

the invoice distribution line will be updated with C (Cancelled). The invoice status flag will also be 

updated to reflect the cancellation on invoices that have not been previously processed by the 

Integration (invoice tax status flag of R or E). These invoices will not be reversed in audit, since 

they do not exist in audit. 
 

To cancel invoices and process invoices with the Integration: 
 

1. Cancel the invoice(s) using the Oracle cancel invoice standard functionality. 

2. Run the Sabrix Tax Process to process or reprocess the invoice(s). 

• The invoice tax status flag is updated from T (Taxed), R (Ready), or E (Error) to C 

(Cancelled). 

• Any future Sabrix Tax Processes will not re-process any invoices with a Sabrix Tax 

Status of C. 

 
For invoices cancelled prior to installing the Integration, the tax status flag is updated when the AP 

Sabrix Tax Process is run for the first time. 

 

 
The following screen shows the Sabrix Tax Status flag after the invoice has been cancelled and 

before re-running the Sabrix Tax Process. Note that all distribution lines are reversed by Oracle 

and the Sabrix Tax Status flag is set to T. 
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After the Sabrix Tax Process is run again, the Tax Status flag is set for all lines to C to indicate 

the invoice has been cancelled. Cancelled invoices will not be reprocessed by the Integration. 

 
After you cancel an invoice and subsequently run the Sabrix Tax Process, related audit records 

are reversed. 

 
 
 
 
 
 

The concurrent program Sabrix Tax Process is only applicable to U.S. Sales and Use 

Tax. This is due to ONESOURCE Indirect Tax Integration for Oracle 12 Version 5.6.0.0 

enhancing the P2P functionality for real time (online) tax calculations for recoverable tax 

details. 
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DEBIT MEMOS 

Determination processes debit memos created in Oracle Payables in much the same way as 

standard invoices, as described in previous sections of this chapter. 
 

Accrual and expense records are returned to the invoice distribution lines if there is a variance in 

the tax that should be returned to the vendor. Determination also has the ability to shortpay debit 

memos, if your business rules call for this functionality. 

 
In order to process a debit memo, you must ensure that at least one distribution Item line has an R 

status. 

 
 

The following example shows the debit memo results where the vendor tax is greater than what 

Determination calculated. The eBTax: Sabrix Overcharge Shortpay Action profile option is set 

to OFF. For more information, see PROFILE OPTIONS FOR SHORTPAY AND/OR ACCRUE 

(page 29). 
 

 
The $12.00 tax was entered into the invoice header Tax Control Amount field, Oracle prorates the 

tax to each authority based on the tax percentages returned from Determination. After the Sabrix 

Tax Process is run, the descriptive flexfield attribute for Sabrix Tax Rate/Amount is updated with 

the Tax Rate, Tax Amount, Vendor Tax Amount and the Vendor Overcharge amount. Oracle then 

reverses the original vendor charge tax amount and re-calculates the vendor charged tax amount. 

 
 

The concurrent program Sabrix Tax Process is only applicable to U.S. Sales and Use 

Tax. This is due to ONESOURCE Indirect Tax Integration for Oracle 12 Version 5.6.0.0 

enhancing the P2P functionality for real time (online) tax calculations for recoverable tax 

details. 



PAYABLES TAX CALCULATIONS 116 

ONESOURCE INDIRECT TAX INTEGRATION FOR ORACLE 12 

PROCURE TO PAY USER’S GUIDE - VERSION 

 

 

REVERSING 

 

 

REVERSING 

If you need to reverse a line or re-tax an invoice after the Sabrix Tax Process has set the Invoice 

Tax Status to T and updated the invoice distribution appropriately, you would: 
 

• Make the necessary change (dollar amount, Ship To, etc.) 

• Reset the Invoice Tax Status field in the descriptive flexfield on at least one of the lines that 

needs to be re-taxed to R. 

• Re-validate the invoice. 

• Re-run the Sabrix Tax Process. 

 
The Sabrix Tax Process will reverse the Integration-generated distribution lines, recalculate tax, 

update the invoice Tax Status to T, and create new distribution lines. 
 

 
 
 
 

 
The concurrent program Sabrix Tax Process is only applicable to U.S. Sales and Use 

Tax. This is due to ONESOURCE Indirect Tax Integration for Oracle 12 Version 5.6.0.0 

enhancing the P2P functionality for real time (online) tax calculations for recoverable tax 

details. 
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WORKING WITH FIXED ASSETS 

Although the Integration does not integrate directly with Oracle Assets, it can send tax distribution 

lines to Oracle Assets. 
 

Integration-created expense distribution lines are automatically associated with fixed assets when 

the following fields are populated for the item line: 
 

• Track as Asset 

• Asset Book 

• Distribution Account equal to the Asset Clearing Account 

 
INTEGRATION TAX EXPENSE ALLOCATION 

In Oracle R12, Miscellaneous invoice lines allocated to an Item line with Fixed Asset information 

are eligible for transferring to Oracle Assets. During the Oracle approval process, the Sabrix Tax 

Expense line is fully allocated to the Item line and the distribution lines are created. This can be 

executed during the Sabrix Tax Process based on the profile option eBTax: Sabrix AP Approve 

Invoices. 
 

If the profile option eBTax: Sabrix AP Approve Invoices, is set to No, the Sabrix Tax Process 

will not execute the Oracle approval process. You must run the Oracle approval process 

separately as your business process dictates. The result is as follows: 
 

• The Integration tax lines are created: 

• The distribution line for the Sabrix Tax Accrual line is created with a Distribution Class 

of Saved. 

• The distribution line for the Sabrix Tax Expense line is created with a Distribution 

Class of Preview. 

• The Invoice Status is Needs Revalidation. 

• The Allocation Status is Pending. 

• Revalidate the invoice. 

• The Allocation Status is Executed, 

• The Sabrix Tax Expense distribution line is saved with a Distribution Class of Saved. 

If the profile option eBTax: Sabrix AP Approve Invoices, is set to Yes, the Sabrix Tax Process 

will execute the Oracle approval process. The result is as follows: 
 

• The Integration tax lines are created. 

• The distribution lines for the Sabrix Tax Accrual and the Sabrix Tax Expense are 

created with a Distribution Class of Saved. 

• The Invoice Status is Validated and the Allocation Status is still Executed. 
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FIXED ASSETS EXAMPLE 

The following example outlines the steps to generate fixed asset information on the Integration 

generated distribution lines. 
 

1. Navigate to the Accounts Payable Invoice Entry form. 

2. Enter the required invoice information shown on this screen according to your company’s 
standard business processes. The Track as Asset flag for the AP Invoice Line and 

Distribution Lines will be checked for the item line when the line distribution is the Asset 

Clearing Account. 

3. Enter the Asset Book. 

4. Enter the Sabrix Tax Status descriptive flexfield segment. 

5. Validate the Invoice. 

6. Run the Sabrix Tax Process. 

 
The following is an example of an invoice after the Sabrix Tax Process has run. The AP Lines 

form shows the Sabrix Tax Expense line referencing the Asset Clearing account and the Track As 

Asset flag is checked: 
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The following shows the AP All Distributions form, including the asset fields. 
 

 
 
 
 

The concurrent program Sabrix Tax Process is only applicable to U.S. Sales and Use 

Tax. This is due to ONESOURCE Indirect Tax Integration for Oracle 12 Version 5.6.0.0 

enhancing the P2P functionality for real time (online) tax calculations for recoverable tax 

details. 



ONESOURCE INDIRECT TAX INTEGRATION FOR ORACLE 12 

PROCURE TO PAY USER’S GUIDE - VERSION 

 

 

120 

 

 

ENABLING ONESOURCE INDIRECT TAX 

DETERMINATION FEATURES 

 

In this chapter, you will learn how to enable some optional Determination features: 
 

• HANDLING DIRECT PAY PERMITS 

• SETTING UP CUSTOM AUTHORITIES (page 124) 

• INPUT VAT RECOVERABILITY (page 125) 

 
 

HANDLING DIRECT PAY PERMITS 

Companies often negotiate with state authorities to self assess and pay transaction taxes 

themselves rather than allow a vendor to calculate, collect and remit the tax to a state. A direct pay 

permit is issued to a legal entity that enables the company to control the calculation and cash flow 

associated with remitting the tax payments. These agreements with the states are known as Direct 

Pay Permits (DPP). Many ONESOURCE Indirect Tax customers have Direct Pay Permits that 

require special handling of transactions that fall under the jurisdiction of the permit. 
 

You should treat a vendor invoice with vendor-determined tax that falls under the jurisdiction of a 

DPP differently from other invoices. Reverse the vendor tax, reduce the invoice amount, and make 

a corresponding accrual, assessing the tax for the company. 
 

When the Integration Procure to Pay processes a transaction: 
 

• The vendor is set to the Oracle vendor and 

• The customer is set to your External Company ID. 

 
Determination evaluates if a certificate is applicable, and if so, applies it. The data returned to the 

Integration has the DDP Exempt Certificate number in the EXEMPTION_CERTIFICATE field and 

the ‘Direct Pay Permit’ in the EXEMPT_REASON field for each applicable authority. This value 

indicates that Direct Payment adjustments to the invoice are needed, as described above. 
 

Transactions with multiple Ship-To addresses or multiple vendor tax amounts on the invoice have 

vendor tax distributions reversed and self-assessed, including those intended jurisdictions for 

which the Direct Pay Permit does not apply. 
 

The Integration then passes a second transaction to Determination to record this information to the 

audit file. 



ONESOURCE INDIRECT TAX INTEGRATION FOR ORACLE 12 

PROCURE TO PAY USER’S GUIDE - VERSION 5.6.2.4 

121 ENABLING ONESOURCE INDIRECT TAX DETERMINATION FEATURES 
 

 

HANDLING DIRECT PAY PERMITS 

 

 
To set up the Direct Pay Permit in Determination for a specific company: 

 

1. Log on to Determination. 

2. Navigate to Menu > System > Companies and click your company name, and then click the 

Company Preferences tab. 

3. If Uses Exemption Certificates is not checked, select it and click Submit. 

4. Navigate to Menu > Company Data > Exemptions and Licenses and click the Exempt 

Reasons tab. 

5. On the Actions menu, select Add. 

6. Enter a new exempt reason using the following information and then click Submit: 
 

Prompt Value 

Long Code Direct Pay Permit 

Short Code DP 

Description Direct Pay Permit 

 

7. Click the Search tab. 

8. From the Actions menu, select Add Customer. 

9. Create a customer with the same name as your Determination company name. For example, 
if your company name is ABC COMPANY, create a customer with the name ABC COMPANY 

and click Submit. 

If you use precalc user exits to populate the EXTERNAL_COMPANY_ID, you must populate 

the CUSTOMER_NUMBER with the same value. 

10. From the Actions menu, select Add Certificate. 

11. Create a certificate using the table below as a guide (Do not check the Fully Exempt box. If 

checked, you will not get an accrual for the tax results): 
 

Prompt Value 

Number Permit Number 

Valid From (Today’s Date) 

Active (Checked) 

Status Approved 

Exempt Reason Direct Pay Permit 

Applies To Choose the appropriate state (for example, Washington) 
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12. Click Submit after you have entered the data (see the example below). 

Do not check the Fully Exempt box. If checked, you will not get an accrual for the tax results. 

 
 
 
 

Once you have created this Direct Pay Permit in Determination, you can use the Direct Pay Permit 

feature for an AP transaction. 
 

When you enter an AP transaction with a Direct Pay Permit, you will see a reversal line generated 

by the Integration. The reversing line description has the following: Sabrix generated total shortpay 

entry due to Direct Pay Permit. 
 

In the example below, the gross amount for the invoice is adjusted to reflect the reversal of a 

vendor-determined tax of $82.50. 
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SETTING UP CUSTOM AUTHORITIES 

This section describes how to set up custom authorities in Determination and in Oracle E-Business 

Tax. 

 
DETERMINATION 

If your AP invoice triggers a tax calculation for a Custom Authority set up in Determination, the 

Integration returns a separate line for the Custom Authority only if it uses a separate tax code from 

the other tax results on your transaction. 
 

In Determination, the configuration for the new tax code is indicated in the ERP Tax Code field for 

the selected authority’s rule that is triggered by the invoice, as shown below: 

See ONESOURCE Indirect Tax Determination Online Help for further details about setting up 

custom authorities. 

 
 

 
ORACLE E-BUSINESS TAX 

You must set up additional tax rate codes for any custom authorities or special fees such as a 

TIREFEE in Oracle E-Business Tax under the SBX_Regime_XX (ISO Country Code) hierarchy. 
 

See CREATING ADDITIONAL TAX RATE CODES FOR PAYABLES (page 130) for additional 

information. 



ENABLING ONESOURCE INDIRECT TAX DETERMINATIONFEATURES 124 

ONESOURCE INDIRECT TAX INTEGRATION FOR ORACLE 12 

PROCURE TO PAY USER’S GUIDE - VERSION 

 

 

INPUT VAT RECOVERABILITY 

 

INPUT VAT RECOVERABILITY 

ONESOURCE Determination has two options for input VAT recoverability tax results, depending 

on how you want to display and account for in Oracle AP. 
 

Options for Input VAT Recoverability are: 
 

• Partially Recoverable tax result can be returned as a single result using the recoverable flag 

and percent recoverable specified on the AP Distribution in Oracle. This is the 

recommended setting for using the Online tax call for VAT transactions. A single tax line 

with be created and the distributions will apportion the Recoverable amount and the 

Nonrecoverable amount. For example 30% recoverable and 70% nonrecoverable. 

• Partially Recoverable tax result can be returned as two separate results: the recoverable 

portion and the non-recoverable tax expense. This will create two separate tax lines. One 

line will be 100% recoverable and the other line with be 100% nonrecoverable. 

 
To configure VAT recoverability: 

 

1. Log on to Determination. 

2. Navigate to System > Companies and then click the Options tab. 
 

 

 
Do NOT set the Determination Company Option Exclude 0% Non-Recoverable Tax Block, Value 

as “Y”. Recommend to leave as Null or “N” 

 
 

• Fully Recoverable has Input Recovery % equal to “1”. 

• Partially Recoverable has Input Recovery % less than but not equal to “1”, e.g. 60% would 

be displayed as “.6” in the XML. 
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Example Partial Recoverable Invoice with Post VAT Nonrecoverable set to N 
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Example Partial Recoverable Invoice with Post VAT Nonrecoverable set to Y 
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SETTING LOCATION TAX CATEGORIES 

Determination allows you to identify when you have a bonded warehouse or other location type 

that requires special tax handling. Because there are many options in the E-Business Suite to 

identify these locations, you must enable this capability using a precalc user exit. See the 

ONESOURCE Indirect Tax Integration for Oracle 12 Installation and Configuration Guide for more 

information about precalc user exits. 
 

For example, if an Inventory organization is a bonded warehouse, you can identify it by its name or 

an attribute. Whenever the warehouse is used, the precalc sets the value for ST_IS_BONDED to 

Yes (ST stands for Ship To). If it is a different type of location, such as a refinery, set the 

ST_LOCATION_TAX_CATEGORY to Refinery. 

 
The Location Tax Category, such as rule qualifiers, requires additional set up in Determination to 

ensure that you use the correct taxation rules. For more information, see ONESOURCE Indirect 

Tax Determination Online Help. 
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ACCOUNT 

 

The ONESOURCE Indirect Tax Integration for Oracle 12 Installation and Configuration Guide 

outlines the process for creating Tax Rate Codes for use by your integration. The process outlines 

creating tax flows for the initial implementation, upgrading from a prior version, as well as creating 

additional information after the initial implementation. For example, you may add a custom 

authority in Determination and want it to have a unique tax rate code and associated accounting. 
 

If you are upgrading from a release prior to 5.6.0.0 and have VAT Tax Rate Codes, you are 

required to run a concurrent process that updates your existing tax flows by creating and 

associating necessary recoverable rates. If this is a new installation or you are creating new tax 

flows, the recoverable rates will be created via that process. 

The sections below describe the process to: 
 

• RECOVERY TAX RATE CODES FOR TAX TO RATE FLOWS 

• CREATING ADDITIONAL TAX RATE CODES FOR PAYABLES (page 130) 

• SABRIX ADD ACCOUNT TO TAX RATE CODE (page 132) 

• MANUALLY ADDING GENERAL LEDGER TAX ACCOUNTS FOR PAYABLES (page 

140) 

• UPDATING GENERAL LEDGER TAX ACCOUNTS FOR PAYABLES (page 143) 

 
 

RECOVERY TAX RATE CODES FOR TAX TO RATE FLOWS 

Tax to Rate flows created prior to ONESOURCE Indirect Tax Integration for Oracle 12 5.6.0.0 do 

not have eBTax Recovery Rate Codes information populated. This data is necessary for VAT 

transactions from release 5.6.0.0 going forward. The concurrent process “Sabrix Setup Recovery 

Rates” can be run once in your installation and will automatically add the required details to your 

existing VAT or GST tax codes. Any new tax codes do not need to have this process run. They will 

create the Recoverable Rate along with the rest of the Tax Flows. 

 
Be sure the Oracle Tax Managers responsibility you are using has the multi-org access to the 

operating units to which you will be defining the Tax Rate Code and associating the general ledger 

accounts. 

 
To run the Sabrix Setup Tax concurrent process: 

 

1. Select the Tax Managers responsibility. 

2. Navigate to Requests > Other > Requests > Run and select a single request. 

3. In the name field, select the concurrent process Sabrix Setup Recovery Rates. 

4. Click Submit. There are no parameters to fill in. 



ONESOURCE INDIRECT TAX INTEGRATION FOR ORACLE 12 

PROCURE TO PAY USER’S GUIDE - VERSION 5.6.2.4 

129 TAX RATE CODES AND GENERAL TAX ACCOUNT 
 

 

CREATING ADDITIONAL TAX RATE CODES FOR PAYABLES 

 
 

Once completed, you can review the accounting to be sure your configuration meets your business 

needs. If you need to make changes, run the Sabrix Add Account to Tax Rate Code concurrent 

process outlined below. It will update accounting on both your tax rate code and your recoverable 

rate code. 

 
 
 

CREATING ADDITIONAL TAX RATE CODES FOR PAYABLES 

If a Default (DFLT) Tax Flow is defined, the Integration can automatically create Tax to Rate Flows 

for ERP Tax Codes returned from Determination that are not defined in Oracle. This allows the 

flows to be created and the transaction to be processed. 
 

Alternatively, a new individual tax flow can be added to an existing Regime by running the 

concurrent process, Sabrix Setup Tax. This process will create the Tax Rate Code and associated 

Tax, Status, Recovery Rate (for AP tax codes in VAT Regimes) and Jurisdiction for the entered 

regime. The general ledger tax accounts are not created by the concurrent process. The tax 

accounts need to be added as an additional step. 

 
Be sure the Oracle Tax Managers responsibility you are using has the multi-org access to the 

operating units to which you will be defining the Tax Rate Code and associating the general ledger 

accounts. 

 
To run the Sabrix Setup Tax concurrent process: 

 

1. Select the Tax Managers responsibility. 

2. Navigate to Requests > Other > Requests > Run and select a single request. 

3. In the name field, select the concurrent process Sabrix Setup Tax. 
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CREATING ADDITIONAL TAX RATE CODES FOR PAYABLES 

 

 
4. Enter the following parameters:. 

 

Prompt Description 

Tax Regime Tax Regime Name. Choose from value set. 

ERP Tax Code Sabrix ERP Tax Code. Choose from value set 

Tax Direction Specifies input/output values for VAT recovery 

identification. Choose from value set. 

Install O2C Create an O2C Tax Flow? Yes or No 

Install P2P Create a P2P Tax Flow? Yes or No 

Start Date Tax Effective Start Date (DD-MMM-YYYY); 

must be on or after the Regime start date 

 

5. Click Submit. 

6. Review the concurrent request log file to confirm successful completion. 

 
See the following sections for more information: 

 

• To add general ledger accounts for a new Tax Rate Code using the concurrent process, see 

SABRIX ADD ACCOUNT TO TAX RATE CODE (page 132) 

• To manually enter general ledger accounts for a new Tax Rate Code, see MANUALLY 

ADDING GENERAL LEDGER TAX ACCOUNTS FOR PAYABLES (page 140). 

• To manually change the general ledger accounts for an existing Tax Rate Code, see 

UPDATING GENERAL LEDGER TAX ACCOUNTS FOR PAYABLES (page 143) 
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SABRIX ADD ACCOUNT TO TAX RATE CODE 

This program will update the general ledger tax accounts on the Tax Rate Code and, for VAT 

installations, the Recoverable Rate Codes. Although in most cases, the general ledger accounts 

can be manually entered via the Tax Accounts form in the Tax Manager responsibility we 

recommend that the Sabrix Add Account to Tax Rate Code program be run to assign all the Tax 

Rate Codes for the specified ERP Tax Code to a specific operating unit’s general ledger tax 

accounts. This process can also be run to change/update the existing general ledger tax accounts 

for all the Tax Rate Codes (i.e. authorities) for the specified ERP Tax Code. 

 
You must execute the concurrent process once for each combination of regime, operating unit, and 
tax rate code. 

 
 
 

 
Thomson Reuters recommends that you use the same general ledger accounts within the ERP Tax 

Code group. An ERP Tax Code group relates to all the Tax Flows associated with the same ERP 

Tax Code. For example, all the city and county authorities within a state will have the same ERP 

Tax Code, such as Washington has USWA. 

 
To run the Sabrix Add Account to Tax Rate Code concurrent process: 

 

1. Select the Tax Managers responsibility. 

2. Navigate to Requests > Other > Requests > Run and select a single request. 

3. In the name field, select Sabrix Add Account to Tax Rate Code. 

4. Enter the following parameters: 
 

Prompt Description 

Tax Regime Tax Regime Name. Choose from value set 

Operating Unit Operating Unit. Choose from value set. 

ERP Tax Code Sabrix ERP Tax Code. Choose from value set 

Workflow Procure to Pay or Order to Cash. Choose from 

value set. 

Tax Direction Specifies input/output values for VAT recovery 

identification. Choose from value set. 
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Prompt Description 

Recoverable/Liability Acct Enter a valid General Ledger account 

combination for the Operating Unit 

Required for O2C and P2P Tax Rate Codes. 

For VAT Regimes in a P2P implementation, 

this program will use this value to update the 

GL account on the Recoverable Rate. 

Tax Expense Acct Enter a valid General Ledger account 

combination for the Operating Unit 

Not Required for P2P or O2C Tax Rate Codes. 

If it is left null, then your tax expense will use 

the general ledger account associated with the 

item distribution on your invoice. For VAT 

Regimes in a P2P implementation, this 

Expense account may be left null for Input tax 

codes, but, for Output tax codes, must be set 

to the Output VAT GL account used above. 

 
 

 
For additional information about which GL accounts to be setup for the Tax Rate Codes 

and Tax Recovery Rates for Input and OutPut Tax Direction for P2P Recoverable/Liability 

Accounts, see the ONESOURCE Indirect Tax Integration for Oracle 12 Installation 

and Configuration Guide Version 5.6.2.4 under the Gather Regime, Tax Code and 

Operating Unit Values section for the Regime to Rate Flow Parameters. 
 

5. Click Submit. 

6. Review the concurrent request log file to confirm successful completion. 

 
For Canadian implementations, to easily identify recoverable vs. non-recoverable amounts in the 

general ledger, it is advised to enter separate Tax Recoverable/Liability accounts for recoverable 

(GST) and non-recoverable (PST) Tax Rate Codes. 
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SABRIX ADD ACCOUNT TO TAX RATE CODE 

 

VIEW TAX RATE CODE ACCOUNTING 

You can verify your tax accounting is set up correctly by reviewing the configuration in EBusiness 

Tax, as follows. 
 

1. Navigate to Tax Configuration > Tax Rates. Search for your newly created Tax Rate Code 

and click on Tax Rate Code. 

 
2. Then click on View Tax Accounts. 
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3. Verify the accounting details. If you did not specify a Tax Expense account, the Tax Expense 

accounting for P2P transactions will mirror the item distribution accounting in the APInvoice. 
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VIEW VAT TAX RECOVERY RATE ACCOUNTS 

For VAT transactions, the recoverability accounting comes from the GL account set up on the 

Tax Recovery Rate Code. To view the Tax Recovery Rate Code: 
 

1. Navigate to Tax Configuration > Tax Recovery Rates. Search for your newly created Tax 

Recovery Rate Code and click the Tax Recovery Rate Code. 
 

 
2. Click on View Tax Accounts. 
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3. Note that the Tax Recoverable/Liability account that displays here on the Tax Recovery Rate 

Code matches the Tax Recoverable/Liability account on Tax Rate Code. 
 

 
 

 
EXAMPLE INPUT VAT TAX RATE CODE AND RECOVERY RATE CODE 

 
Input VAT Tax Rate Code 
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Input VAT Tax Recovery Rate Code 
 

 
 

EXAMPLE OUTPUT VAT RATE AND TAX RECOVERY RATE 
 

Output VAT Tax Rate Code 
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Output VAT Tax Recovery Rate Code 
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MANUALLY ADDING GENERAL LEDGER TAX ACCOUNTS 
FOR PAYABLES 

Thomson Reuters recommends that you use the same general ledger accounts within the ERP Tax 

Code group. An ERP Tax Code group relates to all the Tax Flows associated with the same ERP 

Tax Code. For example, all the city and county authorities within a state will have the same ERP 

Tax Code, such as Washington has USWA. 

 
To enter the general ledger accounts for the new Tax Rate Code: 

 

1. Navigate to Tax Configuration > Tax Rates. Search for your newly created Tax Rate Code 

and click the Update icon. 

2. Click Tax Accounts. 
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3. Enter your accounting Ledger and click Create. 

 

4. Enter the Operating Unit and the Tax Recoverable/Liability GL similar to the example 

shown below. The Tax Expense account is not required. Click Apply on the Create Tax 

Accounts form. 
 

 
 

 
If the Tax Rate Code General Tax Accounts for Tax Expense is null, and vendor charged tax (VCT) 
is entered on the Tax Details Summary as a Tax Only Line, then GL Tax Expense Account is 
required. The Tax Only Line means the tax is not associated to an item line, therefore GL Tax 
Expense accounts cannot be determined when GL Tax Expense account is null on the Tax Rate 
Code. This is based on standard Oracle functionality to derive the GL Tax Expense account from 
the item line if it is null on the Tax Rate Code. Integration is also using the same functionality to use 
the item line GL account if the Tax Rate Code has a null GL Tax Expense account. 
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5. On the Tax Accounts form, click Apply. The Update Tax Rate form will be displayed, click 

Apply. The Tax Rates form will be displayed with the confirmation message indicating your 

changes have been saved. 
 

 
You must repeat the general ledger account entry steps for each operating unit in which the Tax 

Rate Code will be used. 
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UPDATING GENERAL LEDGER TAX ACCOUNTS FOR PAYABLES 

The general ledger accounts defined on a Tax Rate Code can be updated manually (described 

below). To automatically update all the Tax Rate Codes for a specific ERP Tax Code, the Sabrix 

Add Account to Tax Rate Code program can be run. The program will change/update all the Tax 

Rate Codes (i.e. authorities) for the specified ERP Tax Code to a specific operating unit’s general 

ledger accounts. For more information, see SABRIX ADD ACCOUNT TO TAX RATE CODE 

(page 132) 

 
Thomson Reuters recommends that you use the same general ledger accounts within the ERP Tax 

Code group. An ERP Tax Code group relates to all the Tax Flows associated with the same ERP 

Tax Code. For example, all the city and county authorities within a state will have the same ERP 

Tax Code, such as Washington has USWA. 

 
 

 
To easily identify recoverable vs. non-recoverable amounts in the general ledger, it is advised to 

enter separate Tax Recoverable/Liability accounts for recoverable (GST) and non-recoverable 

(PST) Tax Rate Codes. 

 
 

To update the general ledger accounts manually: 
 

1. Select the Tax Managers responsibility. 

2. Navigate to Tax Configuration > Tax Rates form. 

3. Enter the search criteria for the Tax Rate Code you want to update and click Go. 

4. Click the Update icon associated with the Tax Rate Code to be updated. 
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5. Click the Tax Accounts icon. 
 

 
6. Click the Update Tax Accounts icon. 
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7. Update the values in the Tax Recoverable/Liability account value and the Tax Expense 

account value. The Tax Expense GL account is not required for P2P on-line tax calculation 

or the AP Sabrix Tax Process. When the Tax Expense GL account is null on the Tax Rate 

Code, the Tax Expense GL account is then determined from the invoice item lines GL 

account. Click Apply on the Update Tax Accounts form. 
 

 
 
 

If the Tax Rate Code General Tax Accounts for Tax Expense is null, and vendor charged 
tax (VCT) is entered on the Tax Details Summary as a Tax Only Line, then GL Tax 
Expense Account is required. The Tax Only Line means the tax is not associated to an 
item line, therefore GL Tax Expense accounts cannot be determined when GL Tax 
Expense account is null on the Tax Rate Code. This is based on standard Oracle 
functionality to derive the GL Tax Expense account from the item line if it is null on the 
Tax Rate Code. Integration is also using the same functionality to use the item line GL 
account if the Tax Rate Code has a null GL Tax Expense account. 
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8. The Tax Accounts form will be displayed, click Apply. The Update Tax Rate form will be 

displayed, click Apply. The Tax Rates form will be displayed with the confirmation message 

indicating your changes have been saved: 
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REPORTING 

 
 

The ONESOURCE Indirect Tax Integration for Oracle 12 Procure to Pay offers reports to enable 

quick viewing of accruals, log data, transaction data, and other information. This section explains 

the following reports: 
 

• SABRIX AP ACCRUAL REPORT (page 148) 

• SABRIX LOG TABLE MAINTENANCE (page 152) 

• SABRIX TRANSACTION MANAGER (page 155) 

• SABRIX AP TRANSACTIONS DELETE (page 158) 

 
The Sabrix Tax Process and the Sabrix AP Tax Thread processes are described in detail in the 

section SABRIX TAX PROCESS FOR AP U.S. SALES AND USE TAX (page 107). 

 

There are additional reports users may find helpful. See the ONESOURCE Indirect Tax Integration 

for Oracle 12 Installation and Configuration Guide for more information on the following reports: 
 

• Sabrix XML Report - displays XML Indata and XML Outdata from the SABRIX_LOG table. 

• Sabrix New Tax Flows Report - provides visibility to all the Tax Flows created by the 

Integration. 

• GL Tax Account Discrepancies For Sabrix Tax Rate Codes - lists Tax Rate Codes for an 

ERP Code where the general ledger accounts differ. 
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SABRIX AP ACCRUAL REPORT 

You can run the Sabrix AP Accrual Report daily to show activity for all transactions that have 

been processed with accruals, the total dollar amount of all the accruals, and any transactions that 

have generated errors. 
 

This report is a helpful tool to review AP transactions that have Sabrix Tax Accruals, transactions 

with a Sabrix Out of Tolerance hold, and transactions with Determination-generated errors. 
 

The report displays the type of transaction with: 
 

• Supplier Name 

• Invoice Date 

• Invoice Number 

• Invoice Line Number 

• Sabrix Taxable Amounts 

• Sabrix Tax Rate % 

• Sabrix Tax Amount 

• Vendor Tax Amount 

• Sabrix Accrual Amount (total 

dollar amount of Sabrix 

accruals) 

• Status Message 

 
 
 

The last page of the report also has a summary recap of the transaction details based on the 

selected Report Parameters. 

 
 
 

The profile option eBTax: Sabrix AP Create Transactions must be set to Yes for the 

Sabrix_transactions_ap table to be populated with data for this report. See CONFIGURING 

PROFILE OPTIONS (page 4) for more information about this profile option. 
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To run the Sabrix AP Accrual Report: 
 

1. In Payables, navigate to Other > Requests > Run or from the Menu bar View > Requests 

for the report submission page. 

2. Select the desired report and click OK. 
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3. Enter the Operating Unit and then enter the report parameters as needed.using the table 

below as a guide: 
 

 
 

AP Accrual Report Parameters 

Parameter Description 

Sort By Select whether to sort the accrual data by invoice number or invoice date. 

Run ID Low The specific concurrent run id starting number 

Run ID High The specific concurrent run id ending number 

Invoice Number 

Low 

The invoice starting number if you want to run the report for a specific invoice or a 

range of invoices. 

Invoice Number 

High 

The invoice ending number if you want to run the report for a specific invoice or a 

range of invoices. 

Invoice Date Low The invoice starting date if you want to run the report for a specific date or a range 

of dates. 

Invoice Date High The invoice ending date if you want to run the report for a specific date or a range 

of dates. 



REPORTING 150 

SABRIX AP ACCRUAL REPORT 

ONESOURCE INDIRECT TAX INTEGRATION FOR ORACLE 12 

PROCURE TO PAY USER’S GUIDE - VERSION 

 

 

 

 

AP Accrual Report Parameters 

Parameter Description 

Processing Status Processing Status Select from the following choices: 

• E - to run the report for those transactions that have been placed on hold due to 

an error. 

• C - to run the report for those transactions that have been cancelled. 

• O - to run the report for those transactions that are out of tolerance 

• T - to run the report for those transactions that have completed successfully. 

Display Detail Select from the following choices: 

INVOICE - to have the report display detail at the invoice level. 

LINE - to have the report display detail at the line level. 

ROLLUP LINE - to have the report display line information with rolled up invoice 

totals 

 

4. After you complete the parameters form, click OK and then Submit. 

5. Navigate to the Concurrent Manager to view the report. 

 
The following is a sample accrual report: 
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SABRIX LOG TABLE MAINTENANCE 

The Integration is fully integrated with Oracle's error handling capabilities. The Sabrix Log Table 

Maintenance process can be used to clean and purge the SABRIX_LOG table. This process is 

not operating unit-specific since it is used for Sabrix tables, which are not operating unit-specific. 
 

A significant amount of detail for every transaction is included in the SABRIX_LOG table, including: 
 

• Input value from Oracle 

• Output value from the Determination 

• Process dialog and interim values 

• Transaction source 

• Profile option values 

• XML Input and Output to and from Determination 

 
All transaction data (not just AP transactions) is stored in the SABRIX_LOG table, including the 

appropriate workflow (O2C or P2P). The information can be cleaned or purged using the Sabrix 

Log Table Maintenance concurrent program. 

 
The log messages for all transaction data (not just AP transactions) are written to an Oracle 

database table, SABRIX_LOG table, located in the Sabrix schema. The Integration can maintain 

the logs resulting from Integration processes. The Integration writes logs to tables in the Sabrix 

schema. 
 

For details on logging when processing Oracle Payables transactions, see the CONFIGURING 

TAX PROCESS LOGGING AND XML SETTINGS (page 113) 
 

Timing statistics for AP transactions can be viewed on the Sabrix Log Manager report if the profile 

option eBTax: Sabrix Debug Level is set to Timing. This setting will write procedure entry and exit 

messages for AP transactions in the SABRIX_LOG table. 
 

When processing Receivables, Order Management, and Purchasing transactions, log data is 

controlled by the profile option eBTax: Sabrix Debug Level settings of ALL, OFF, USER, XML, 

and WARNING, in conjunction with the eBTax: Sabrix System Print Structure setting. See the 

CONFIGURING PROFILE OPTIONS (page 4), for more information. 
 

See the ONESOURCE Indirect Tax Integration for Oracle 12 Installation and Configuration Guide, 

“Configuring Profile Options” section, for more information. 
 

Maintenance of these logs are managed by the Sabrix Log Table Maintenance concurrent 

program. Maintenance actions depend upon the setting of the program parameter values listed 

below: 
 

• CLEAN - data for the parameters (retention days, start and end dates, etc) selected willbe 

deleted from the log table. 

• PURGE - the log table is emptied, iether entirely or all transactions based on the workflow 

parameter. 

 
The selected action outlined above will be performed on ALL transaction logging data in the 

SABRIX_LOG table, including Receivables, Order Management, Payables, and Purchasing 

transactions. 
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Once the data is deleted or purged from the SABRIX_LOG table, the XML data is also deleted or 

purged. Therefore, reports (Sabrix XML Report) will contain no data for the filtered criteria. 

 

The process parameters include the Action (Clean or Purge), Workflow (O2C or P2P), Retention 

Days (the number of days to retain the transaction data - used for CLEAN action only), the start 

and end dates. (date parameters are for CLEAN action only). 
 

If an error occurs during transaction processing, you are notified. Full rollback capabilities ensure 

that Determination and Oracle Applications remain in agreement. Even with these safeguards in 

place, with the level of control granted to administrators and superusers, it is possible to manually 

circumvent these controls and introduce inconsistencies. For this purpose, the Integration includes 

reconciliation reports for matching Oracle distributions to audit transactions. 
 

See the Sabrix Log Report concurrent process, which enables you to review the data in the 

SABRIX_LOG table without requiring a DBA or Developer to gather the data. See the 

ONESOURCE Indirect Tax Integration for Oracle 12 Installation and Configuration Guide for more 

information. 

To run the Sabrix Log Table Maintenance program: 
 

1. In the Tax Manager responsibility, navigate to Requests > Other > Requests > Run. 

2. Select Sabrix Log Table Maintenance. 
 
 

 

3. Enter information on the Parameters page. 
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Parameter Sample Value Comment 

Retention 

(Days) 

7 The number of days to retain the transaction data in the Sabrix 

Log table. This parameter will work with the Start Date parameter. 

The process will retain data in the Sabrix Log table fo rthe 

number of days in the past starting at the Start Date parameter 

value or sysdate (if no start date is entered). This parameter is 

used only for the ‘CLEAN’ action. 

This parameter is required and defaults to 7. 

Action CLEAN Note: Action will be performed on ALL data in the Sabrix Log 

Table, this includes AR, OM, AP, and PO transactions. This 

parameter will work in conjunction with the ‘Workflow’ parameter 

(described below), taking action on only the data for the workflow 

selected. 

• CLEAN: Data for the parameters (Retention Days, Startand 

End Dates, etc) selected will be deleted from the logtable. 

• PURGE: The entire log table is emptied, either entirely or all 

transactions based on the workflow parameter. 

The default is CLEAN. 

Start Date 12-MAY-2011 A start date for a date range for the action of ‘CLEAN’. This 

parameter works in conjunction with the Retention Days 

parameter. 

A null value defaults to sysdate. 

End Date 12-MAY-2011 The ending date for a date range for the action of ‘CLEAN’. This 

parameter works in conjunction with the Start Date parameter. 

A null value defaults to sysdate. 

Workflow Procure to Pay The workflow, Order to Cash or Procure to Pay, associated with 

the transaction data. The selection is used in conjunction with the 

‘Action’ parameter. 

A null value defaults to all transactions. 

 

The Sabrix Log Table Maintenance program could be scheduled to run periodically in order to 

keep the Sabrix Log table from getting too large. To do this, contact your IT department or 

someone who is responsible for scheduling concurrent jobs. 
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SABRIX TRANSACTION MANAGER 

The Integration provides a method for IT personnel to maintain the transaction tables resulting 

from ONESOURCE Indirect Tax processes. The Integration writes transactions to tables in the 

Sabrix schema. This process is not Operating Unit-specific since it is used for Sabrix tables that 

are not Operating Unit-specific. The Sabrix Transaction Manager concurrent program manages 

these tables, and depending upon the setting of parameters listed in the table below, can: 
 

• Delete or clean transactions older than a specified date. 

• Delete or clean transactions for a specified date range. 

• Purge all records from the transaction table 

 
The selected action outlined above will be performed on ALL data in the Sabrix tables, this 

includes, Receivables, Order Management, Payables, and Purchasing transactions. 

 

The Sabrix schema tables managed by the Sabrix Transaction Manager include: 
 

• SABRIX_INVOICE 

• SABRIX_INVOICE_OUT 

• SABRIX_INVOICE_TAX 

• SABRIX_LICENSE 

• SABRIX_LICENSE_OUT 

• SABRIX_LINE 

• SABRIX_LINE_TAX 

• SABRIX_LINE_OUT 

• SABRIX_MESSAGE 

• SABRIX_REGISTRATION 
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SABRIX TRANSACTION MANAGER 

 

 
To run the Sabrix Transaction Manager: 

 

1. In Oracle Tax Manager, navigate to Requests>Other>Requests>Run. 

2. Select the Sabrix Transaction Manager 

3. Enter information on the Parameters page: 
 

 

Transaction Manager Configuration Parameters 

Parameter Sample Value Comment 

Duration 

(Days) 

7 The length of time in days to delete an entry in the table; 

mutually exclusive with Start Date. 

Action PURGE Note: Action will be performed on ALL data in the Sabrix Log 

Table, this includes AR, OM, AP, and PO transactions. 

 
• PURGE: Remove all records from the transaction tables 

via TRUNCATE. 

• CLEAN: Remove all records older than Duration daysold 

or all records which fall between the dates specified by 

Start Date and End Date. 

The default is CLEAN. 

Start Date 12-MAY-2011 A start date for a date range for which transactiontable 

contents will be deleted. 

The default is today's date minus 14 days. Mutually 

exclusive with Duration. 
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Transaction Manager Configuration Parameters 

Parameter Sample Value Comment 

End Date 12-MAY-2011 An end date for a date range for which transaction table 

contents will be deleted 

The default is today's date minus 7 days. 

Document 

Number 

Inv123 The parameter will validate an invoice or a PO number in this 

field. If either exists, the log manager will perform the action 

stated in the Action parameter for that document. 

Request ID 4126279 The log manager will perform the action stated in the Action 

parameter for the specific request id. 

Type List of Values • INPUT: Selected to delete/purge the records from the 

tmp_sabrix_invoice_input table. 

• OUTPUT: Selected to delete/purge the records from the 

tmp_sabrix_invoice_output table. 

• BOTH: Selected to delete/purge the records from boththe 

input and output tables. This is the default value for the 

parameter. 
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SABRIX AP TRANSACTIONS DELETE 

 

 

SABRIX AP TRANSACTIONS DELETE 

This report maintains the SABRIX_TRANSACTIONS_AP table. This table stores transaction 

information about the invoices that have been processed. Invoices marked in error are shown in 

the table along with information to assist with handling errors. This process is not Operating Unit- 

specific since it is used for Sabrix tables that are not Operating Unit-specific. When the table 

becomes too large, this concurrent process will delete it based on the set of parameters entered. 
 

When you run the report, enter the parameters using the table below as a guide: 
 

 

 

AP Transaction Delete Parameters 

Parameter Sample Value Comment 

Invoice Age (days) 15 Any invoices older than 15 days will be purged 

from the table 

Invoice Date From 01-JUN-06 Use Invoice Date From and Invoice Date To 

in conjunction. Invoices within this range will 

be deleted. 
Invoice Date To 31-DEC-06 

Invoice Number Any Invoice Number Any occurrences of this invoice number will be 

deleted. 
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